The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

PRODUCT MODULES AND OPTIONS. This guide contains descriptions of modules that are optional and for which you may not have purchased a license. Siebel’s Sample Database also includes data related to these optional modules. As a result, your software implementation may differ from descriptions in this guide. To find out more about the modules your organization has purchased, see your corporate purchasing agent or your Siebel sales representative.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
Chapter 1: Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

Contacting Technical Support 7
TTY Access to Oracle Support Services 7
Documentation Accessibility 7
   Accessibility of Code Examples in Documentation 7
   Accessibility of Links to External Web Sites in Documentation 7
Structure 8
Related Documents 8
Do Not Use Database Tools to Modify Oracle Applications Data 8
Glossary 9

Chapter 2: Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment

About Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 11
Software Requirements 13
Data Quality 14
Cross-References 14
Language Support 15

Chapter 3: Installing and Configuring the Applications

Process of Installing Components 17
   Downloading Required Software for Installation 17
   Installing Fusion Middleware Software 18
   Installing Oracle E-Business Suite Patches 18
   Installing Fusion Middleware and JDeveloper Patches 20
   Installing and Deploying Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 21
Configuring Components 21
   Locating Integration Files 22
   Configuring and Deploying Common Schema 23
Contents

Configuring the Domain Value Maps 24
Configuring the Error Logging Database 25
Configuring Siebel CRM On Demand Session Pooling 26
Creating Oracle E-Business Suite Connection Information 27
Creating OracleCRMODDataSource 28
Creating Error Database Connection Information 29
Creating J2EE Data Sources 29
Creating Adapter Data Sources 31
Preparing Business Processes Execution Language Processes for Deployment 32
Deploying the Business Processes Execution Language Processes Using Automatic Process Deployment 33
Configuring the Servers Using JDeveloper for Manual Process Deployment 35
Deploying the Business Processes Execution Language Processes Manually 36
Setting Business Processes Execution Language Options 38
Setting Service Oriented Architecture Suite Proxy Server Properties 39
Finding Business Processes Execution Language Endpoint URLs for E-Business Suite Profiles 39
Starting the CRMIntegSEBLODPollingSchedulerAsync Process 40
Purging Process Instances on the Business Processes Execution Language Console 40

Process of Configuring the Oracle E-Business Suite Environment 41
  Configuring Oracle Warehouse Builder 41
  Configuring Oracle Warehouse Builder for the Customer Integration 42
  Configuration Changes for Customer Data 44
  Creating a Synchronization Account 44
  Configuring Changes for Product Data 46
  Configuring for Quoting Integration 47

Process of Configuring the Siebel CRM On Demand Environment 50
  Creating Web Tabs 50
  Creating Web Links 51
  Modifying Layouts 53
  Creating Custom Fields 55
  Modifying Roles 55
  Enabling Web Services 56
  Merging Records 56
  Personal Information Manager Synchronization 57
  Modifying Pick Lists 57
  Changing Themes 58
  (Optional) Setting Up the Client-Side Browser 58

About Using Customized Fields 58
Chapter 4: Initial Bulk Loading of Customer, Contact, and Product Data

Bulk Loading of Customer and Contact Data 60
Bulk Loading of Product Data 61

Process of Importing CSV Files into Siebel CRM On Demand 62
  Launching the Siebel CRM On Demand import Wizard 63
  Using the Import Wizard 64
  Configuring the CRMIntegSEBLODAddressLoader.exe.config File 64
  Using the Address Import Executable 65

Chapter 5: About Integrating Customer Data, Products, and Quotes

Integration Assumptions 67
  Oracle E-Business Suite User Management Assumptions 67
  Customer Data Synchronization Assumptions 67
  Product Data Synchronization Assumptions 68

Customer Data Integration 68
  Synchronization Flows 68
  Customer Data Mappings 78

Product Integration 84
  Product Integration Notes 84
  User Procedures 85
  Product Mappings 85

Quote Integration 86
  Integration Features 86
  Integration Overview 87

Chapter 6: Troubleshooting

Error Messages 93
Error Logging Database 93
Resolving Errors 94

NoClassDefFound Error on BPEL Process Auto-Deployment 96
Siebel CRM On Demand to Oracle E-Business Suite Address Synchronization Failures 96

Index
Contacting Technical Support

The CRM On Demand Training and Support Center is a single access point to a wide range of help, training, and support resources that help you get more out of Siebel CRM On Demand. It provides 24/7 access to create and modify service requests as well as display system status alerts and notifications. To access the Training & Support Center, log into Siebel CRM On Demand (http://www.oracle.com/crmondemand/index.html) and click on the Customer Care link.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers might not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to the Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.
Structure

1. Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite
2. Siebel CRM On Demand Integration Pack for Oracle E-Business Suite Environment
3. About Integrating Customer Data, Products, and Quotes
4. Installing and Configuring the Applications
5. Initial Bulk Loading of Customer, Contact, and Product Data
6. Troubleshooting

Related Documents

For more information, see the following documents:

- Oracle Customers Online User Guide
- Oracle Customers Online Implementation Guide
- Oracle Quoting Implementation Guide
- Oracle Quoting User Guide
- Oracle Trading Community Architecture User Guide
- Oracle Trading Community Architecture Administration Guide
- Oracle Trading Community Technical Implementation Guide
- DQM Administration Guide
- Siebel CRM On Demand Online Help

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle strongly recommends that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data, and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change that you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications, you can change a row in one table without making the corresponding changes in the related tables. If your tables are out of synchronization with each other, you risk retrieving erroneous information, and you risk unpredictable results throughout Oracle Applications.
When you use Oracle Applications to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. If you enter information into database tables using database tools, you can store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

**Glossary**

360° View. A screen within the Oracle Customer Online application that displays a comprehensive list of contracts, credit information, email interactions, invoices, orders, quotes, payments, projects, and service requests for a given customer.

Account. In Oracle an account describes the specific attributes of a party that are relevant to the selling relationship that the implementing organization has established with a party. An account in Oracle cannot exist by itself without a party. It can be associated with an individual (person) or a company (organization). In Siebel CRM On Demand an account describes an organizational customer.

BES. Oracle Business Event System based on Oracle Workflow.

BOM. Bill of materials—defines the components and hierarchy of a product.

BPEL. Business Processes Execution Language, a standards-based extensible language.

Catalog Category. A category is a logical classification of items that have similar characteristics.

Category Set. Category sets can be used as a means of developing custom lists of items, which you can report and sort. A category set is a distinct grouping scheme and consists of categories.

CBM. The created_by_module column in Trading Community Architecture tables.

CDH. Oracle Customer Data Hub.

Contact. In Oracle E-Business Suite 11i, a contact describes a specific relationship between two parties, more specifically between an Organization and a Person party, which is also called an Organization Contact. The Organization Contact can also be associated with a Customer account in Oracle, which is then called an account contact. In Siebel CRM On Demand a contact describes an individual customer who might or might not be related to an account (Organization customer) or another contact (individual customer).

Customer. In Oracle E-Business Suite 11i a customer is defined as a party with whom the implementing organization has established a selling relationship. All relevant information of the specific selling relationship with a party is modeled in the account layer entities in Oracle, whereas all the base information like name, address information, contact points are modeled in the party layer entities. A customer in Oracle can be an individual (person) in the case of a Business-to-Consumer relationship, or a company (organization) in the case of a Business-to-Business relationship. In Siebel CRM On Demand a customer can be either modeled as an account or as a contact. An account in Siebel CRM On Demand is the equivalent of an organization party and account in Oracle, and a contact is the equivalent of a person party and account in Oracle.

FMW. Fusion Middleware.

Install Base. An Oracle record of the goods and services that a customer owns.
Introduction to Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

Glossary

**Item.** A product or service that is manufactured or sold. Items can be used to represent grouping assemblies or placeholders such as phantoms.

**Middleware.** Integration software that is used to connect applications, such as Webmethods.

**Oracle EBS.** Oracle E-Business Suite applications.

**Order Management.** Refers to organizations as warehouses on all Order Management windows and reports.

**Organization.** A business unit, such as a plant, warehouse, division, department, and so on.

**OS.** The orig_system column in Trading Community Architecture table.

**OWB.** Oracle Warehouse Builder.

**Party.** In the Oracle E-Business Suite 11i, more specifically in the Trading Community Architecture, a party is defined as any individual or organization with whom the implementing organization can do business. A party in Oracle Trading Community Architecture could be a customer (for example, in the case of a selling relationship), a vendor, or an employee. The same party can have multiple such roles within Oracle E-Business Suite 11i. In the context of this integration solution only those parties in Oracle E-Business Suite 11i that represent customer data are addressed. The concept of a party does not exist in Siebel CRM On Demand.

**SOA.** Service Oriented Architecture.

**SCOD.** Siebel CRM On Demand application.

**TCA.** Trading Community Architecture.
This chapter describes the environment needed for Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. It contains the following information:

- About Siebel CRM On Demand Integration Pack for Oracle E-Business Suite on page 11
- Software Requirements on page 13
- Data Quality on page 14
- Cross-References on page 14
- Language Support on page 15

About Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite integrates account, customer, order, and quote information between Siebel CRM On Demand and Oracle E-Business Suite. The functionality provided by this integration includes:

- Creating accounts with Data Quality Management
- Creating contacts with Data Quality Management
- Enabling Siebel CRM On Demand opportunity to Oracle E-Business Suite quote conversion business process
- Synchronizing customer data from Oracle E-Business Suite to Siebel CRM On Demand
- Synchronizing customer data from Siebel CRM On Demand to Oracle E-Business Suite
- Synchronizing product data from Oracle E-Business Suite to Siebel CRM On Demand
Figure 1 shows an overview of the components of the integration.
Oracle E-Business Suite data objects and Siebel data objects do not have an exact 1:1 equivalence for every field. To convert the data appropriately, the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite uses Fusion Middleware (FMW) and Oracle Business Process Execution Language (BPEL). Figure 2 shows this architecture.

**Initial Bulk Load**

![Integration Architecture](image)

**Updates and Transactions**

FMW and BPEL are used in the real-time updates between Oracle E-Business Suite and Siebel CRM On Demand. However, before these products can be used together, a one-time initial data load is needed to synchronize Siebel CRM On Demand with Oracle E-Business Suite. For more information about initial loading of data, see Chapter 4, “Initial Bulk Loading of Customer, Contact, and Product Data.”

**Software Requirements**

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite requires the following versions:

- Oracle 10.1.3.1 Application Server Enterprise Edition
- Oracle E-Business Suite, 11.5.10 CU2
- Oracle JDeveloper 10.1.3.1 (upgraded to the latest patch)
- Oracle SOA Suite 10.1.3.1 (upgraded to the latest patch)
- Oracle Warehouse Builder 10gR2 (Optional)
Data Quality

You can choose to enable the standard Oracle Data Quality Management (DQM) duplicate check when creating new customer data. A profile option within Oracle E-Business Suite can control this functionality (see Table 8 on page 46).

Within the process flow that creates the new Siebel CRM On Demand customer in Oracle E-Business Suite and later also in Siebel CRM On Demand, the Oracle Data Quality Management (DQM) Search Service can be called to identify possible duplicate customers during data entry and before the customer is created in Oracle E-Business Suite. The user can control whether the DQM Search Service is called from the process flow using a standard profile option in Oracle E-Business Suite (see Table 8 on page 46).

If you choose to check for duplicates in Oracle E-Business Suite and if the Oracle DQM Search Service returns one or more possible duplicate customer records, the possible duplicate customer records are displayed to the user in the user interface. The user can then choose to either pick one of the existing customers (in case the newly entered customer is a true duplicate), or create the new customer record in Oracle E-Business Suite (in case the newly created customer is not a duplicate). If the user chooses to pick a customer that already exists in Oracle E-Business Suite, the process orchestration flow retrieves the customer record from Oracle E-Business Suite and creates the customer record in Siebel CRM On Demand. This flow assumes that the user has already executed a duplicate search within Siebel CRM On Demand before entering into the Create Account/Contact transaction.

Cross-References

To support ongoing customer data synchronization between Oracle E-Business Suite and Siebel CRM On Demand, a cross-reference of the unique identifiers of customer data is maintained in Siebel CRM On Demand. The entities that are cross-referenced on the Siebel side are account, address, and contact, which correspond to organization, party site and an organization contact in Oracle E-Business Suite.

For newly created customer records in Oracle E-Business Suite that need to be synchronized with Siebel CRM On Demand, Oracle E-Business Suite publishes the Oracle unique identifiers, which may be mapped to the External ID attribute of the appropriate entity in Siebel CRM On Demand to establish the cross-references within Siebel CRM On Demand.

For updated customer records that need to be synchronized with Siebel CRM On Demand, Oracle publishes the Oracle unique identifiers. The Siebel CRM On Demand Web Service interfaces are able to uniquely identify the records in Siebel CRM On Demand that need to be updated.

Oracle does not store the Siebel CRM On Demand unique identifier of the customer record.
Language Support

Table 1 lists the languages supported for databases as part of this integration pack.

Table 1. Supported Languages for Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Language</th>
<th>Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (Simplified)</td>
<td>ZHS16GBK</td>
</tr>
<tr>
<td>German</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>English-British</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>English-American</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>Spanish</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>French</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>Italian</td>
<td>WE8MSWIN1252</td>
</tr>
<tr>
<td>Japanese</td>
<td>JA16SJIS</td>
</tr>
<tr>
<td>Korean</td>
<td>KO16MSWIN949</td>
</tr>
<tr>
<td>Portuguese</td>
<td>WE8MSWIN1252</td>
</tr>
</tbody>
</table>

Base the product data synchronization on the Siebel CRM On Demand company's default language.
Language Support
This chapter describes how to install and configure the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. It also describes how to configure the Oracle E-Business Suite and Siebel CRM On Demand to work with Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. This chapter contains the following sections:

- Process of Installing Components on page 17
- Configuring Components on page 21
- Process of Configuring the Oracle E-Business Suite Environment on page 41
- Process of Configuring the Siebel CRM On Demand Environment on page 50
- About Using Customized Fields on page 58

### Process of Installing Components

Complete the following tasks to install the components for Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. These tasks must be completed in the specific order listed:

1. **Downloading Required Software for Installation on page 17**
2. **Installing Fusion Middleware Software on page 18**
3. **Installing Oracle E-Business Suite Patches on page 18**
4. **Installing Fusion Middleware and JDeveloper Patches on page 20**
5. **Installing and Deploying Siebel CRM On Demand Integration Pack for Oracle E-Business Suite on page 21**

### Downloading Required Software for Installation

This media pack contains the necessary files to support integration between Oracle E-Business Suite and Siebel CRM On Demand. Download these files from http://edelivery.oracle.com by choosing Oracle Application Integration Architecture from the Product Pack drop-down menu and choosing the platform to be used for your SOA Suite installation.

Download the following files:

2. Oracle Database 10g Release 2 (10.2.0.1) (file name(s) and count vary by platform)
3. Oracle Database 10g Release 2 Patches (DB_Patches_AIAv1.0.zip)
4. Oracle SOA Suite 10g (10.1.3.1.0) (file name(s) and count vary by platform)
Installing and Configuring the Applications  ■ Process of Installing Components

5 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, Fusion Middleware Patches (FMW_Patches_AIAv1.0.zip)


7 Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, v1.1, (SEBLODIntegPkEBSv1.1.zip)

Installing Fusion Middleware Software

Install the following Fusion Middleware components:

1 Oracle Database 10g Release 2 (10.2.0.1) Enterprise Edition.
   Download and install the database only if you do not already have an Oracle 10.2.0.2 (or higher) database instance available for the SOA Suite to access. For information on installing Oracle Database, refer to the Oracle Technology Network. Oracle Technology Network link has the following URL:
   http://www.oracle.com/technology/documentation/index.html
   After installation, apply the appropriate patch from DB_Patches_AIAv1.0.zip (choose the patch appropriate to the operating system that your database is installed on.) This patch brings the database up to required version 10.2.0.2.

2 SOA Suite 10g10.1.3.1
   For information on installing Oracle SOA Suite, refer to the Oracle Application Server Documentation Library. The library is available on the Oracle Technology Network.
   Oracle Technology Network link has the following URL:
   http://www.oracle.com/technology/documentation/index.html

3 Oracle JDeveloper 10.1.3.1 (Studio Version)
   Download Oracle JDeveloper from:
   This is a free download. Support for JDeveloper is not included. If desired, support for JDeveloper can be purchased separately. For information on installing Oracle JDeveloper, refer to the Oracle Technology Network. Oracle Technology Network link has the following URL:
   http://www.oracle.com/technology/documentation/index.html

4 Oracle Warehouse Builder 10gR2 10.2.0.1 (optional component)
   Oracle Warehouse Builder is an optional component that should be used to perform initial data synchronization from Oracle E-Business Suite to Siebel CRM On Demand if customer or product data already exists in E-Business Suite. Use of OWB for initial data synchronization requires the ETL and Data Quality options from Oracle Warehouse Builder. OWB is not included in this media pack and, if needed, must be licensed separately.

Installing Oracle E-Business Suite Patches

Install the Oracle E-Business Suite patches described in this section. If a patch has already been installed, there is no need to reinstall it. The latest version of each patch can be downloaded from http://metalink.oracle.com.
1. Download the Oracle E-Business Suite patches. The file name is: EBS_Patches_AIAv1.1.tar.gz

2. Use the tar utility to extract the Oracle E-Business Suite patches from EBS_Patches_AIAv1.1.tar.gz. The command is:
   \texttt{tar -xzf EBS\_Patches\_AIAv1.1.tar.gz}

3. After extracting, there are two tar files: platform.tar and generic.tar.

4. Extract these two tar files using these commands:
   \texttt{tar -xf platform.tar}
   \texttt{tar -xf generic.tar}

5. Extracting from generic.tar yields a set of platform-independent EBS patch zip files. Apply each of these patches to your Oracle E-Business Suite application.

6. Extracting from platform.tar yields six platform-specific tar files:
   aix.tar, hpux11.tar, linux.tar, solaris.tar, tru64.tar, and winnt.tar.

7. Use the appropriate platform file for your Oracle E-Business Suite installation to yield the platform-specific patch zip files.
   Example: \texttt{tar -xf solaris.tar}

8. Apply each of these patches to your Oracle E-Business Suite application.

Table 2 lists the patches that must be installed for Oracle E-Business Suite (EBS).

**NOTE:** Always check Metalink for the latest versions of all patches.

### Table 2. Mandatory Patches for Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Patch Number</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>3618299 (HZ.N)</td>
<td>This patch is a prerequisite for patch 5046954.</td>
</tr>
<tr>
<td>5046954</td>
<td>This patch contains PL/SQL Application Programming Interfaces that are called by the integration processes. It also contains the code that raises business events that are picked up by the integration processes.</td>
</tr>
<tr>
<td>5221628</td>
<td>Oracle E-Business Suite patch contains the new Oracle E-Business Suite user interface for create account, create contact, and so on, which are embedded in Siebel CRM On Demand as Web links. It also contains Subscription to Business Events.</td>
</tr>
<tr>
<td>6021150</td>
<td>This patch enables product business events, which are used for product synchronization between Oracle E-Business Suite and Siebel CRM On Demand.</td>
</tr>
<tr>
<td>5368824</td>
<td>This patch hides hyperlinks on Data Quality Management pages.</td>
</tr>
<tr>
<td>5398458</td>
<td>Enhancements for OCO Transaction Viewer.</td>
</tr>
<tr>
<td>5451612</td>
<td>A JTT patch that enables Quoting Navigation.</td>
</tr>
<tr>
<td>5505578</td>
<td>This patch installs Quoting updates.</td>
</tr>
<tr>
<td>5605532</td>
<td>This patch installs the Order Capture updates.</td>
</tr>
</tbody>
</table>
Installing and Configuring the Applications  ■ Process of Installing Components

Table 2.  Mandatory Patches for Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Patch Number</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>5839660</td>
<td>UIX version 2.2.24 and patch for Oracle E-Business Suite 11.5.10CU2.</td>
</tr>
<tr>
<td>5916062</td>
<td>This patch is to be applied to the Oracle EBS HTTP Server enables non-ASCII character support.</td>
</tr>
</tbody>
</table>

Table 3 lists recommended patches to be installed.

Table 3.  Recommended Patches for Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Patch Number</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>4280097</td>
<td>This patch is required if you are using Customer Merge capabilities in Oracle E-Business Suite.</td>
</tr>
<tr>
<td>4351001</td>
<td>This patch hides the Update icon on Duplicate Prevention pages.</td>
</tr>
<tr>
<td>4775835</td>
<td>Fixes an error in messageLOVChoice for Country and Currency when used with the custom Siebel CRM On Demand Look and Feel in combination with a non-English language.</td>
</tr>
</tbody>
</table>

Installing Fusion Middleware and JDeveloper Patches

Install the Fusion Middleware and JDeveloper patches described in this section. If any particular patch has already been installed, there is no need to reinstall it. The latest version of each patch can be downloaded from http://metalink.oracle.com.

1 Download the Fusion Middleware and JDeveloper patches. The file name is: FMW_Patches_AIAv1.0.zip

2 Unzip the file to yield the mandatory bug-fix patches listed in Table 4.

Table 4 lists the patches that must be installed.

Table 4.  Patches for Fusion Middleware and JDeveloper

<table>
<thead>
<tr>
<th>Patch Number</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>5473225</td>
<td>Fixes problems that involve catching an exception during a transform.</td>
</tr>
<tr>
<td>5596476</td>
<td>Fixes problems that involve the XSLT map not rendering in the user interface.</td>
</tr>
<tr>
<td>5609537</td>
<td>Fixes issues with commit in child processes.</td>
</tr>
</tbody>
</table>
3. Apply each of these patches to your installation.
4. Refer to the ReadMe.txt in each patch for guidance on how to apply the patch.

### Installing and Deploying Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

To extract the integration files, complete the following procedure.

**To deploy the integration on SOA Suite**

1. Unzip file Fmw_apr07_rup.zip under <SOA Suite Home>/BPEL directory (this directory is created during the SOA Suite Installation.)
   Unzipping extracts a copy of this ReadMe file and SEBLODIntegPkEBS.zip that contains the integration files.
2. Unzip SEBLODIntegPkEBS.zip. Unzipping extracts the integration files into a new directory named:
   SEBLODIntegPkEBS.

### Configuring Components

This section covers the configuration of components. These tasks must be completed in the specific order listed:

1. **Locating Integration Files** on page 22
2. **Configuring and Deploying Common Schema** on page 23
3. **Configuring the Domain Value Maps** on page 24
4. **Configuring the Error Logging Database** on page 25

---

Table 4. Patches for Fusion Middleware and JDeveloper

<table>
<thead>
<tr>
<th>Patch Number</th>
<th>Comments</th>
</tr>
</thead>
</table>
| 5917910      | Fixes problems that involve:  
  - Creating `<XSL:variable>` with value `"&#0;"`  
  - Java heap error on Service Oriented Architecture Suite, V10.1.3.1 release on Linux.  
  - Invoking PL/SQL procedure with a large output parameter. |
| 5931554      | Fixes problems that involve:  
  - Cross-reference feature  
  - XPATH function, LOOKUP-DVM, but does not work in assign activity of Business Processes Execution Language. |
Installing and Configuring the Applications

5 Configuring Siebel CRM On Demand Session Pooling on page 26
6 Creating Oracle E-Business Suite Connection Information on page 27
7 Creating OracleCRMODDataSource on page 28
8 Creating Error Database Connection Information on page 29
9 Creating J2EE Data Sources on page 29
10 Creating Adapter Data Sources on page 31
11 Preparing Business Processes Execution Language Processes for Deployment on page 32
12 Deploying the Business Processes Execution Language Processes Using Automatic Process Deployment on page 33
14 Deploying the Business Processes Execution Language Processes Manually on page 36
15 Setting Business Processes Execution Language Options on page 38
16 Setting Service Oriented Architecture Suite Proxy Server Properties on page 39
17 Finding Business Processes Execution Language Endpoint URLs for E-Business Suite Profiles on page 39
18 Starting the CRMIntegSEBLODPollingSchedulerAsync Process on page 40
19 Purging Process Instances on the Business Processes Execution Language Console on page 40

Locating Integration Files

The integration files are contained in the SEBLODIntegPkEBS directory. This directory was created when you unzipped SEBLODIntegPkEBS.zip according to the instructions in the Siebel CRM On Demand Integration Pack Quick Installation Guide.

The SEBLODIntegPkEBS directory contains the following directories:

- **BulkDataLoad.** Has content for performing an initial data load of customer and product data from Oracle E-Business Suite to Siebel CRM On Demand, if necessary.
- **BusinessProcesses.** Has content for ongoing synchronization. These are the Oracle Business Processes Execution Language (BPEL) processes and related content.
- **SetUp.** Contains setup content for BPEL Processes.
- **SharedComponents.** Has shared components for BPEL Processes.

You need these directories and their files to complete the remaining installation and configuration tasks.
Configuring and Deploying Common Schema

To configure the common schema use the following procedure. Table 5 shows the parameters being used and their purpose.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;jdbc.url&gt;</td>
<td>The URL of the database used by BPEL installation.</td>
</tr>
<tr>
<td>&lt;olite.user&gt;</td>
<td>The user name for the database used by BPEL installation.</td>
</tr>
<tr>
<td>&lt;olite.password&gt;</td>
<td>The corresponding password for &lt;olite.user&gt;.</td>
</tr>
<tr>
<td>&lt;od.username&gt;</td>
<td>Your Siebel CRM On Demand administration user name.</td>
</tr>
<tr>
<td>&lt;od.password&gt;</td>
<td>The corresponding password for &lt;od.username&gt;.</td>
</tr>
<tr>
<td>&lt;ProxyHost&gt;</td>
<td>The URL for the Proxy host where the proxy server is running.</td>
</tr>
<tr>
<td>&lt;session.timeout&gt;</td>
<td>The time out value for a session.</td>
</tr>
<tr>
<td>&lt;session.badDue&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;od.webservice.endpoint&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ProxyPort&gt;</td>
<td>The port number for Proxy port.</td>
</tr>
<tr>
<td>&lt;max.session.size&gt;</td>
<td>The number of Siebel CRM On Demand sessions to be pooled in SOA Server. A suggested value is 5.</td>
</tr>
</tbody>
</table>

To configure CRM On Demand session parameters

1. Create a CRM On Demand Session parameter table:

   ```sql
   create table od_sessionparam (Name varchar(1024) NULL, Value varchar(1024) NULL)
   ```

2. Seed the CRM On Demand Session Parameter table with the following configuration parameters:

   ```sql
   insert into od_sessionparam (Name, Value) Values ('od.password','<odpassword>')
   insert into od_sessionparam (Name, Value) Values ('od.username','<odusername>')
   insert into od_sessionparam (Name, Value) Values ('max.session.size','3')
   insert into od_sessionparam (Name, Value) Values ('session.timeout','5')
   insert into od_sessionparam (Name, Value) Values ('session.badDue','10')
   insert into od_sessionparam (Name, Value) Values ('ProxyHost','<proxyhost>')
   insert into od_sessionparam (Name, Value) Values ('ProxyPort','<proxyport>')
   insert into od_sessionparam (Name, Value) Values ('QueryPageSize','100')
   insert into od_sessionparam (Name, Value) Values ('ConfigTable','ORABPEL.OD_CONFIG')
   insert into od_sessionparam (Name, Value) Values ('od.webservice.endpoint','<CRMOD Server URL>/Services/Integration')
   insert into od_sessionparam (Name, Value) Values ('AccountDetail','<CRMOD Server URL>/OnDemand/user/AccountDetail?OMRET0=%2fOnDemand%2fuser%2fAccountHomePage&OMTHD=AccountDetailNav&OMTTG=AccountDetailForm.Id=[%%AccountId%%]&ocTitleField=Name&ocEdit='
Installing and Configuring the Applications  ■ Configuring Components

3 Restart the SOA Suite server.

4 To verify, make sure that the following URL shows an XML file:

   http(s)://[SOA HOST]:[PORT]/orabpel/xmllib/SEBLODIntegPkEBS/CRMIntegSEBLODSchema.xsd

Configuring the Domain Value Maps

A sample Domain Value Map (DVM) is provided as an XML file conforming to the Oracle SOA Suite DVM schema. Use ESB administration to import the XML file. You can then modify it as needed by adding additional rows, but do not change the following:

■ The DVM name
■ Column names
■ The number of columns

The following DVMs are used in the customer integration:

■ **STATE or PROVINCE in EBS.** In Oracle E-Business Suite there are two properties captured for an address (HZ_LOCATION), STATE or PROVINCE. For each country only one property needs to be used. For the US, this DVM is not used, instead the STATE property is used. For other countries the default is PROVINCE. Each row has a two-digit country code (for example: US) and a corresponding property preference (for example: STATE). Its XML filename can be located at:

   /SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/STATE or PROVINCE in EBS.xml

■ **Country Code Mapping between Oracle E-Business Suite and Siebel CRM On Demand.** Oracle E-Business Suite uses two character country codes, but Siebel CRM On Demand uses the entire name of the country. To compensate for this difference, this mapping file is used to look up the corresponding Siebel CRM On Demand country code when synchronizing account and contact records. Its XML filename can be located at:

   /SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/CRMIntegSEBLODCountryISOCodes.xml
To configure the domain value map
1. From the Oracle SOA Suite main page (http(s)://[SOA HOST]:[PORT]/) click on the ESB Control link.
2. Log in with an administrative user name.
3. Click the DVM icon.
4. Choose Create > Import New Map
5. Select the following file and click OK.
   `/SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/STATE or PROVINCE in EBS.xml`
   This creates a domain value map named STATE or PROVINCE in EBS.
6. Choose Create > Import New Map.
7. Select the following file and click OK.
   `/SEBLODIntegPkEBS/SharedComponents/Utility/DVM/Maps/CRMIntegSEBLODCountryISOCodes.xml`
   This creates a domain value map named CRMIntegSEBLODCountryISOCodes.

The above steps establish the default domain value maps. Update these to reflect the actual values in your Oracle E-Business Suite and Siebel CRM On Demand instances.

Configuring the Error Logging Database
The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite needs an error logging database.

To configure the database
1. Decide on a password for the ERRORADMIN account and substitute it for the `<PASSWORD>` variable in the following step.
2. Create the following user:
   ```sql
   CREATE USER ERRORADMIN
   IDENTIFIED BY VALUES '<PASSWORD>'
   DEFAULT TABLESPACE ERRORHANDLING
   TEMPORARY TABLESPACE TEMP
   PROFILE DEFAULT
   ACCOUNT UNLOCK;
   ```
3. Grant the following user privileges:
   ```sql
   GRANT ALTER ANY TABLE TO ERRORADMIN;
   GRANT ALTER ANY TYPE TO ERRORADMIN;
   GRANT CREATE SESSION TO ERRORADMIN;
   GRANT CREATE SYNONYM TO ERRORADMIN;
   GRANT CREATE ANY TABLE TO ERRORADMIN;
   GRANT CREATE ANY TYPE TO ERRORADMIN;
   ```
GRANT DROP ANY TABLE TO ERRORADMIN;
GRANT UNLIMITED TABLESPACE TO ERRORADMIN;
GRANT INSERT ANY TABLE TO ERRORADMIN;
GRANT SELECT ANY TABLE TO ERRORADMIN;
GRANT UPDATE ANY TABLE TO ERRORADMIN;

4 Create the ERROR_DATABASE table in the ERRORADMIN schema.

```
GRANT DROP ANY TABLE TO ERRORADMIN;
GRANT UNLIMITED TABLESPACE TO ERRORADMIN;
GRANT INSERT ANY TABLE TO ERRORADMIN;
GRANT SELECT ANY TABLE TO ERRORADMIN;
GRANT UPDATE ANY TABLE TO ERRORADMIN;

CREATE TABLE ERROR_DATABASE
(
    CALLINGPROCESSNAME        VARCHAR2(60 BYTE),
    CALLINGPROCESSINSTANCEID  VARCHAR2(10 BYTE),
    FAULTTEXT                 VARCHAR2(1000 BYTE),
    FAULTSTACK                VARCHAR2(1000 BYTE),
    FAULTCONTEXT              VARCHAR2(200 BYTE),
    PROCESSINPUTPAYLOAD       CLOB
);
```

Configuring Siebel CRM On Demand Session Pooling

For the best performance, Siebel CRM On Demand sessions need to be cached in an SOA middle tier. Cached sessions need to be pooled across BPEL processes. Perform the following setup on the Oracle Database used by BPEL Process manager.

**To configure the Siebel CRM On Demand session pooling table**

1 Using the <olite.user>, <olite.password>, and <JDBC.URL> specified in CRMIntegSEBLODConfig.xml, create the following table and insert the following rows (currently there are five rows assuming that <max.session.size> is set to 5 in CRMIntegSEBLODConfig.xml. If there are more than five, insert additional rows, with each row having a unique SESSION_NUM value.)

```
CREATE TABLE OD_POOL
    (SESSION_NUM int NOT NULL,
     SESSION_ID CHAR(255) NULL,
     IS_LOCKED  CHAR(10) NOT NULL,
     LAST_RELEASED timestamp NULL,
     LAST_LOCKED  timestamp NULL);

INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, LAST_LOCKED) VALUES(1, null, 'N', null, null);
INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, LAST_LOCKED) VALUES(2, null, 'N', null, null);
INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, LAST_LOCKED) VALUES(3, null, 'N', null, null);
INSERT INTO OD_POOL(SESSION_NUM, SESSION_ID, IS_LOCKED, LAST_RELEASED, LAST_LOCKED) VALUES(4, null, 'N', null, null);
```
Creating Oracle E-Business Suite Connection Information

To create Oracle E-Business Suite connections, use the following procedure.

**To configure Oracle E-Business Suite connection information**

1. From the Oracle SOA Suite main page click the link for Application Server Control.
2. Log in as an administrative user.
3. Under All Application Servers, click on the SOA application server name.
4. Click on the OC4J J2EE container name.
5. Click Administration tab.
6. Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.
7. Under Connection Pools, click Create.
8. From the Application picklist, choose the appropriate domain (for example: default).
9. Under Connection Pool Type, choose New Connection Pool.
10. Click Continue.
11. Enter this name: OracleEBSDataSource
12. Under URL, click on JDBC URL and enter appropriate host:port:service name. For example: `jdbc:oracle:thin:@<EBS Server URL>:<Port>:<ServiceName>`
13. Under Credentials, enter an E-Business Suite username and password that has APPS schema privilege (for example, APPS/APPS.)
14. Click Finish.
15. Test the connection by clicking Test Connection for the OracleEBSDataSource you created.
16. Click Test.
   
   If successful, a confirmation message appears.
Creating OracleCRMODDataSource

To create OracleCRMODDataSource, use the following procedure.

**To create OracleCRMODDataSource**

1. From the Oracle SOA Suite main page click the link for Application Server Control.
2. Log in as an administrative user.
3. Under All Application Servers, click the SOA application server name.
4. Click the OC4J J2EE container name.
5. Click the Administration tab.
6. Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.
7. Under Connection Pools, click Create.
8. From the Application picklist, choose the appropriate domain (for example: default).
9. Under Connection Pool Type, choose New Connection Pool.
10. Click Continue.
11. Enter this name:
    
    OracleCRMODDataSource

12. Under URL, click on JDBC URL and enter appropriate host:port:service name. For example:
    
    `jdbc:oracle:thin:@example.com:<Port>:exampleInstance`

13. Under Credentials, enter the appropriate error database JDBC URL username and password.
14. Click Attributes.
15. Specify the following attribute values:
    
    ■ Initial size of Connection Cache: 5
    ■ Minimum number of connections: 5
    ■ Maximum number of connections: -1
    ■ Connection Retry Interval (seconds): 1

16. For the remaining attributes, accept the default values.
17. Click Finish.
18. Test the connection by clicking Test Connection for the OracleCRMODDataSource you created.
19. Click Test.

    If successful, a confirmation message appears.
Creating Error Database Connection Information

To create error database connections, use the following procedure.

**To configure error database connection information**

1. From the Oracle SOA Suite main page click the link for Application Server Control.
2. Log in as an administrative user.
3. Under All Application Servers, click on the SOA application server name.
4. Click on the OC4J J2EE container name.
5. Click Administration tab.
6. Navigate to Administration Tasks > Services > JDBC Resources, and then click Go to Task.
7. Under Connection Pools, click Create.
8. From the Application picklist, choose the appropriate domain (for example: default).
9. Under Connection Pool Type, choose New Connection Pool.
10. Click Continue.
11. Enter this name: ErrorDB.
12. Under URL, click on JDBC URL and enter appropriate host:port:service name. For example: jdbc:oracle:thin:@<EBS Server URL>:<Port>:<ServiceName>
13. Under Credentials, enter the appropriate error database JDBC URL username and password.
14. Click Finish.
15. Test the connection by clicking Test Connection for the ErrorDB you created.
16. Click Test.

If successful, a confirmation message appears.

Creating J2EE Data Sources

To create J2EE data sources, use the following procedure.

**To create J2EE data sources**

1. Create the following data sources:
   - jdbc/OracleEBSDataSource
   - loc/OracleCRMODDataSource
   - loc/OracleEBSDataSource
   - jdbc/ErrorDB
   - loc/ErrorDB
2 Create jdbc/OracleEBSDataSource
   a Under Data Sources, click Create.
   b Under Application, choose an appropriate domain name from the pick list.
   c Under Data Type Source, select Managed Data Source.
   d Click Continue.
   e Enter this name: jdbcOracleEBSDataSource.
   f Enter this location: jdbc/OracleEBSDataSource.
   g Pick Transaction level: Global & Local Transactions.
   h Pick Connection Pool: OracleEBSDataSource.
   i Click Finish.

3 Create loc/OracleEBSDataSource.
   a Follow the steps above, except:
   b Enter name: locOracleEBSDataSource.
   c Enter location: loc/OracleEBSDataSource.
   d Pick Transaction level: Local Transactions Only.

4 Create jdbc/ErrorDB.
   a Follow the steps above, except:
   b Enter name: jdbcErrorDB.
   c Enter location: jdbc/ErrorDB.
   d Pick Transaction level: Global & Local Transactions.
   e Pick Connection Pool: ErrorDB.

5 Create loc/ErrorDB.

6 Follow the steps above, except:
   a Enter name: locErrorDB.
   b Enter location: loc/ErrorDB.
   c Pick Transaction level: Local Transactions Only.
   d Pick Connection Pool: ErrorDB.

7 Create loc/OracleCRMODDataSource
   a Under Data Sources, click Create.
   b Under Application, choose an appropriate domain name from the pick list.
   c Under Data Type Source, select Managed Data Source.
   d Click Continue.
   e Enter this name: locOracleCRMODDataSource.
Enter this location: loc/OracleCRMODDataSource.

Pick Transaction level: Local Transactions Only.

Pick Connection Pool: OracleCRMODDataSource.

Click Finish.

Creating Adapter Data Sources

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite needs data sources for the adapters.

To create adapter data sources

1. From the Oracle SOA Suite main page click link for Application Server Control.
2. Log in as an administrative user.
3. Under All Application Servers, click on your SOA application server name.
4. Click on your OC4J J2EE container name.
5. Click Applications tab.
6. Click domain name.
7. Configure AppsAdapter
   a. Click AppsAdapter module.
   b. Click Connection Factories
   c. Click Create above JNDI Location.
   d. Leave default for Connection Factory Interface and Click Continue.
   e. For JNDI location enter: eis/Apps/OracleEBSDataSource.
   f. Under Connection Pooling select No Connection Pool.
   g. Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and xADataSource as jdbc/OracleEBSDataSource.
   h. Click Finish.
8. Configure AQ Adapter
   a. Click AqAdapter module.
   b. Click Connection Factories
   c. Click Create above JNDI Location.
   d. Leave default for Connection Factory Interface and Click Continue.
   e. For JNDI location enter: eis/AQ/OracleEBSDataSource.
   f. Under Connection Pooling select No Connection Pool.
Installing and Configuring the Applications  ■ Configuring Components

9 Configure DB Adapter
a Click DbAdapter module.
b Click Connection Factories
c Click Create above JNDI Location.
d Leave default for Connection Factory Interface and Click Continue.
e For JNDI location enter: eis/DB/OracleEBSDataSource.
f Under Connection Pooling select No Connection Pool.
g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and xADataSource as jdbc/OracleEBSDataSource.
h Click Finish.
i Click Create above JNDI Location.
j Leave default for Connection Factory Interface and Click Continue.
k For JNDI location enter eis/DB/ErrorDB.
l Under Connection Pooling, select No Connection Pool.
m Under Configuration Properties, enter dataSource as loc/ErrorDB and xADataSource as jdbc/ErrorDB.
n Click Finish.

Preparing Business Processes Execution Language Processes for Deployment

Before you can deploy the BPEL process, you must complete some preparation steps.

To prepare Business Processes Execution Language processes
1 Locate the following file and open it for editing:
   /SEBLODIntegPkEBS\SetUp\CMIntegProcessParameters.xml

2 Edit the following parameters.
a Change PARAMVALUE for PARAMNAME “http://127.0.0.1:8888/orabpel/default” to:
   http(s)://[YOUR HOST NAME]:[YOUR PORT NUMBER]/orabpel/[YOUR BPEL DOMAIN NAME]
b Change PARAMVALUE for PARAMNAME “http://127.0.0.1:8888/orabpel/xmllib” to:
   http(s)://[YOUR HOST NAME]:[YOUR PORT NUMBER]/orabpel/xmllib
Go to \SEBLODIntegPkEBS\SetUp\scripts and run the following command to update the BPEL processes with the values specified in CRMIntegProcessParameters.xml.

```
java -jar EditParam.jar -i <Project Root> -f <CRMIntegProcessParameters.xml Location> -verbose -t D:/temp
```

For example:

```
java -jar EditParam.jar -i d:/SEBLODIntegPkEBS/BusinessProcesses -f d:/SEBLODIntegPkEBS/Setup/CRMIntegProcessParameters.xml -verbose -t D:/temp
```

NOTE: To run EditParam.jar, you need Java Development Kit version 1.4 or newer installed.

Copy the contents of \SEBLODIntegPkEBS\BusinessProcesses\Utilities\classes from the build to //<SOA Server>/bpel/system/classes.

Restart the SOA Server:

a. Log in to <SOA Server>/em.
b. Select the SOA Instance.
c. Click Restart.
d. Click Yes on the next two confirmation messages.
e. Wait until you get a successful restart response message from the SOA Server.

Deploying the Business Processes Execution Language Processes Using Automatic Process Deployment

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite may either be deployed manually or with an automated deployment script. For information on deploying manually, read Configuring the Servers Using JDeveloper for Manual Process Deployment on page 35.

If you choose automatic deployment, there are two slightly different procedures: one for deploying the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite BPEL processes for the first time, and one for updating an existing installation of Siebel CRM On Demand Integration Pack for Oracle E-Business Suite processes.

To deploy BPEL processes for the first time

NOTE: This procedure is for the automatic deployment of the BPEL processes assuming no previous processes have been deployed for the integration on the SOA server.

1. Make sure that the \SEBLODIntegPkEBS folder is on the same machine where the BPEL processes are to be deployed.

   If the folder is not already there, move it to a middle-tier machine after running the EditParam.jar and executing the previous procedures. The \SEBLODIntegPkEBS folder should be copied under <SOA HOME>\bpel\samples directory.

2. From a command prompt, run this command:

   a. For Windows:
Installing and Configuring the Applications ▪ Configuring Components

3 Navigate to SEBLODIntegPkEBS\BusinessProcesses and run this command:

   ant

4 Ignore warnings, if any, while the script is running.

5 Restart the SOA Server.

6 Restart the polling process. For more information, read Starting the CRMIntegSEBLODPollingSchedulerAsync Process on page 40.

To update BPEL processes in an existing implementation

**NOTE:** This procedure is for the automatic deployment of the BPEL processes where processes from an existing or new implementation have been deployed for the integration on the SOA server.

1 Restart the SOA Server.

2 Make sure that the \SEBLODIntegPkEBS folder is on the same machine where BPEL Processes are to be deployed.

   If the folder is not already there, move it to a middle-tier machine after running the EditParam.jar and executing all the previous procedures. The \SEBLODIntegPkEBS folder should be copied under <SOA HOME>\bpe|\samples directory.

3 From a command prompt, run this command:

   <SOA_HOME>/bpe|\bin\devprompt.sh

4 Navigate to SEBLODIntegPkEBS\BusinessProcesses and run this command:

   ant

5 Ignore warnings, if any, while the script is running.

6 Clear the WSDL cache on the SOA Server:

   a Go to the BPEL Console.
   b Click the BPEL Processes tab.
   c Click Clear WSDL Cache.

7 Restart the SOA Server.

8 Restart the polling process. For more information, read Starting the CRMIntegSEBLODPollingSchedulerAsync Process on page 40.
Configuring the Servers Using JDeveloper for Manual Process Deployment

Before you can manually deploy the BPEL processes, you must first configure the application server and the integration server. Do not use this procedure if you have used automatic deployment as described in Deploying the Business Processes Execution Language Processes Using Automatic Process Deployment on page 33.

To configure the external jar - CRMODSessionParam.jar
1. Close all open instances of JDEVELOPER.
2. Copy the jar file located under this folder:
   \SEBLODIntegPkEBS\BusinessProcesses\Utilities\dist
to:
   <JDEV Install folder>/Jdev/lib/ext

To configure the application server
1. Open Oracle JDeveloper.
2. Click Connections Navigator.
3. Under Connections, double-click on Application Server.
4. Click Next.
5. Enter a name for ConnectionName to represent the SOA Suite application server.
6. From Connection Type, select Oracle Application Server 10g 10.1.3.
7. Click Next.
8. For UserName, enter the SOA instance username.
9. For Password, enter the SOA instance password.
10. Select Deploy Password.
11. Click Next.
12. For Hostname, enter the server on which the SOA instance is runs.
13. For OPMN Port, leave the default.
14. For OC4J Instance Name, enter the OC4J instance name given during the installation.
15. Click Next.
16. Click Test Connection.
    If successful, a confirmation message appears.
**To configure the integration server**

1. Open Oracle JDeveloper.
2. Click Connections Navigator.
3. Under Connections, double-click on Integration Server.
4. Click Next.
5. Enter a name for ConnectionName to represent the SOA Suite application server.
6. Click Next.
7. Under Application Server, select the server created in the previous step.
8. Change the port name, as needed, to indicate the port at which SOA Suite instance runs.
9. Click Next.
10. Click Test Connection.
    
    If successful, a confirmation message appears.

**Deploying the Business Processes Execution Language Processes Manually**

Use the following procedure to deploy the BPEL processes manually. Do not use this procedure if you have used automatic deployment as described in Deploying the Business Processes Execution Language Processes Using Automatic Process Deployment on page 33.

**To deploy Business Processes Execution Language processes**

1. In JDeveloper, use File > Open to open SEBLODIntegPkEBS/BusinessProcesses/ODSProject.jws
   
   This opens a workspace named ODSProject, which contains the BPEL processes.
2. Right-click on ODSProject, and choose Add to ODSProject.jws
3. Browse to SEBLODIntegPkEBS/BusinessProcesses/SEBLOD/CRMIntegRemoveContactSEBLODSync.
4. Select CRMIntegRemoveContactSEBLODSync.jpr
5. Click Open.
   
   This brings one additional process into the workspace.
6. For each of the following projects compile the Java code by right-clicking each project name and choosing Make:
   - CRMIntegSEBLODGetSession
   - CRMIntegSEBLODPollingSchedulerAsync
   - CRMIntegSEBLODReleaseSession
7. Ignore the warnings listed on the build output window.
For each process in Table 6, complete the following steps to compile and deploy.

a. Right-click on the process name, and choose Deploy > <IntegrationServerName> > Deploy to your specified domain.

b. Ignore any warnings listed on the Compiler tab.

c. Check Apache Ant tab for deployment status.

**NOTE:** These processes must be deployed in the order listed in Table 6.

**Table 6. Deployment Order of BPEL Processes**

<table>
<thead>
<tr>
<th>Order</th>
<th>Process Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRMIntegSEBLODGetSession</td>
</tr>
<tr>
<td>2</td>
<td>CRMIntegSEBLODReleaseSession</td>
</tr>
<tr>
<td>3</td>
<td>CRMIntegErrorHandlerService</td>
</tr>
<tr>
<td>4</td>
<td>CRMIntgXformEBS11i10OrgToSEBLOD11Account</td>
</tr>
<tr>
<td>5</td>
<td>CRMIntgXformSEBLOD11AccountToEBS11i10Org</td>
</tr>
<tr>
<td>6</td>
<td>CRMIntegUpdateOrgEBS11i10Sync</td>
</tr>
<tr>
<td>7</td>
<td>CRMIntegUpdateOrgSEBLOD11ToEBS11i10Async</td>
</tr>
<tr>
<td>8</td>
<td>CRMIntegXformProductODOrToComEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>9</td>
<td>CRMIntegProductUpsertInterface</td>
</tr>
<tr>
<td>10</td>
<td>CRMIntegProductUpsertEBS11iToSEBLODAsync</td>
</tr>
<tr>
<td>11</td>
<td>CRMIntegSEBLODContactInterfaceSync</td>
</tr>
<tr>
<td>12</td>
<td>CRMIntegSEBLODContactValidator</td>
</tr>
<tr>
<td>13</td>
<td>CRMIntegSEBLODAccountInterfaceSync</td>
</tr>
<tr>
<td>14</td>
<td>CRMIntegSEBLODAccountValidator</td>
</tr>
<tr>
<td>15</td>
<td>CRMIntegSEBLODPollUpdatedAccountsAsync</td>
</tr>
<tr>
<td>16</td>
<td>CRMIntegSEBLODPollUpdatedContactsAsync</td>
</tr>
<tr>
<td>17</td>
<td>CRMIntegSEBLODTimeInterfaceSync</td>
</tr>
<tr>
<td>18</td>
<td>CRMIntegSEBLODUserInterfaceSync</td>
</tr>
<tr>
<td>19</td>
<td>CRMIntegSEBLODPollingSchedulerAsync</td>
</tr>
<tr>
<td>20</td>
<td>CRMIntegAccountLookupEBS11i10toSEBLODSync</td>
</tr>
<tr>
<td>21</td>
<td>CRMIntegContactLookupEBS11i10ToSEBLODSync</td>
</tr>
<tr>
<td>22</td>
<td>CRMIntegContactUpsertEBS11i10ToSEBLODSync</td>
</tr>
<tr>
<td>23</td>
<td>CRMIntegAccountUpsertEBS11i10ToSEBLODSync</td>
</tr>
<tr>
<td>24</td>
<td>CRMIntegCreateActEBS11i10ToSEBLOD11Async</td>
</tr>
</tbody>
</table>
Setting Business Processes Execution Language Options

BPEL needs these specific settings for this integration.

To set time out values

1. From the Oracle SOA Suite main page click the link for BPEL Control.
2. Log in as an administrative user.
3. Click Manage BPEL Domain
4. Set syncMaxWaitTime to 300.
5. Open the following file for editing:
   ```xml
   <SOA_HOME>/j2ee/<domain>/application-deployments/orabpel.ejb.ob_engine/orion-ejb.jar.xml
   ```

Table 6. Deployment Order of BPEL Processes

<table>
<thead>
<tr>
<th>Order</th>
<th>Process Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>CRMIntegCreateContSEBLOD11ToEBS11i10Sync</td>
</tr>
<tr>
<td>26</td>
<td>CRMIntegSEBLODOpportunityInterfaceAsync</td>
</tr>
<tr>
<td>27</td>
<td>CRMIntegSEBLODLeadInterfaceAsync</td>
</tr>
<tr>
<td>28</td>
<td>CRMIntegLeadUpsertEBS11iToSEBLODSync</td>
</tr>
<tr>
<td>29</td>
<td>CRMIntegOpportunityUpsertEBS11iToSEBLODSync</td>
</tr>
<tr>
<td>30</td>
<td>CRMIntegCreateOrgEBS11i10Sync</td>
</tr>
<tr>
<td>31</td>
<td>CRMIntegCreateOptySEBLOD11Sync</td>
</tr>
<tr>
<td>32</td>
<td>CRMIntegCreateOrgSEBLOD11ToEBS11i10Sync</td>
</tr>
<tr>
<td>33</td>
<td>CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync</td>
</tr>
<tr>
<td>34</td>
<td>CRMIntegSyncProductEBS11i10ToSEBL782Async</td>
</tr>
<tr>
<td>35</td>
<td>CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>36</td>
<td>CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>37</td>
<td>CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>38</td>
<td>CRMIntegUpdateActEBS11i10ToSEBLOD11Async</td>
</tr>
<tr>
<td>39</td>
<td>CRMIntegSEBLODActivityInterfaceSync</td>
</tr>
<tr>
<td>40</td>
<td>CRMIntegRemoveContactSEBLODSync</td>
</tr>
<tr>
<td>41</td>
<td>CRMIntegObjectMergeEBS11i10ToSEBLODSync</td>
</tr>
<tr>
<td>42</td>
<td>CRMIntegMergePartyEBS11i10ToSEBLOD11Async</td>
</tr>
</tbody>
</table>
6  Find the transaction-timeout for the CubeEngineBean element and set its value to 120.
7  Save the file.
8  Restart the SOA application server.

Setting Service Oriented Architecture Suite Proxy Server Properties

If the SOA server where the BPEL processes are deployed is behind a proxy server, then you must specify the proxy server information.

To set the Service Oriented Architecture Suite proxy server properties
1  From the Oracle SOA Suite main page click the link for Application Server Control.
2  Log in as an administrative user.
3  Under All Application Servers, click on your SOA application server name.
4  Click on your OC4J J2EE container name.
5  Click Administration tab.
6  Click Server Properties under Administration Tasks > Properties.
7  Add the following properties, adjusting the property values to suit your installation:
   ■  -Dhttp.proxySet=true
   ■  -Dhttp.useProxy=true
   ■  -Dhttp.proxyHost=www.example.com
   ■  -Dhttp.proxyPort=80
   ■  -Dhttp.nonProxyHosts=*example.com
8  Remove any duplicates of the above

Finding Business Processes Execution Language Endpoint URLs for E-Business Suite Profiles

When you set up profiles in Oracle E-Business Suite for this integration, you need to provide BPEL endpoint URLs. Follow these steps to find that information.

To find Business Processes Execution Language endpoint URLs
1  From the Oracle SOA Suite main page click the link for BPEL Control.
2  Log in as an administrative user.
3  For a process, click the WSDL tab to find endpoint location.
Use these values to set the appropriate profile options in Oracle E-Business Suite.

**Starting the CRMIntegSEBLODPollingSchedulerAsync Process**

To start the polling process, complete the following task.

_**To start the CRMIntegSEBLODPollingSchedulerAsync process**_
1. From the Oracle SOA Suite main page click the link for BPEL Control.
2. Log in as an administrative user.
3. Click BPEL Processes tab.
4. Click CRMIntegSEBLODPollingSchedulerAsync process.
5. Click Initiate to start this process.
6. Provide the following values to the process:
   - **Unit** = S (for seconds)
   - **Frequency** = 3600 (for one hour)
   - **WindowStart** = (leave this blank to force polling to pick up from where it left off)
7. Click Post XML Message.
8. Click the Instances tab to check if the instances are getting polled.

**Purging Process Instances on the Business Processes Execution Language Console**

As a monthly maintenance measure you can purge the process instances.

_**To purge process instances on the Business Processes Execution Language console**_
1. From the Oracle SOA Suite main page click the link for BPEL Control.
2. Log in as an administrative user.
3. Click Instances tab.
4. Click Purge All Instances.
5. Click Delete All Instances.
6. In the warning message, click Delete All Instances.
   
   This step stops the Siebel CRM On Demand Polling process. When purging is complete, restart the CRMIntegSEBLODPollingSchedulerAsync process.
Process of Configuring the Oracle E-Business Suite Environment

To configure the Oracle E-Business Suite environment, perform the following configuration tasks:

- Configuring Oracle Warehouse Builder on page 41
- Configuring Oracle Warehouse Builder for the Customer Integration on page 42
- Configuration Changes for Customer Data on page 44
- Configuring Changes for Product Data on page 46
- Configuring for Quoting Integration on page 47

Configuring Oracle Warehouse Builder

This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

Oracle Warehouse Builder is an optional component, used to perform initial data synchronization from Oracle E-Business Suite to Siebel CRM On Demand, if customer or product data already exists in Oracle E-Business Suite. If no bulk data loads are required, then you do not need to use Oracle Warehouse Builder. Use of Oracle Warehouse Builder for initial data synchronization requires the ETL and Data Quality options from Oracle Warehouse Builder. Oracle Warehouse Builder is not included in this bundle and, if needed, must be licensed separately.

Before configuring Oracle Warehouse Builder, make sure you have Oracle Warehouse Builder 10g Release 2 installed. Warehouse Builder 10g Release 2 (10.2) is supported and certified for use with the following releases of the Oracle database:

- Oracle9i Release 2 (9.2.x, patched to the latest version) Enterprise Edition
- Oracle Database 10g Enterprise Edition R1 (10.1.x)
- Oracle Database 10g Standard Edition R2 (10.2.x)
- Oracle Database 10g Enterprise Edition R2 (10.2.x)

To configure Oracle Warehouse Builder

1. Install the Oracle Warehouse Builder repository on the Oracle database.

2. Make sure that the database character set is compatible with the character set of the Oracle E-Business Suite database.

   Normally, the Oracle E-Business Suite database has the UTF8 character set. In this case, the character set of the Oracle Warehouse Builder repository database is UTF8 or AL32UTF8. Table 1 on page 15 lists the complete mapping between Siebel CRM On Demand supported language and the Oracle database character set.

   **NOTE:** Do not use Excel to edit CSV files generated by Oracle Warehouse Builder, because it might create difficulties that relate to the character sets.

4 Choose Advanced setup.
5 Enter the connection information (system password, host name, port, and so on).
6 Choose Manage Repository Owner.
7 In the resulting dialog box, select the check box, Skip check box, and click OK.
8 Select the option, Create new Oracle Warehouse Builder Repository owner.
9 Enter a username and password.

The Oracle Warehouse Builder Repository Owner user is required to start and stop the Oracle Warehouse Builder Control Center. The Oracle Warehouse Builder Control Center must be running to be able to use Oracle Warehouse Builder.

10 Select the appropriate tablespaces, and click Next.
11 Click Create New User.
12 Enter the user information (user name, password, and so on).
13 Grant each user "select" access to v_$parameter table. For example, "grant select on v_$parameter to owbdpl".

You can create multiple Oracle Warehouse Builder repository users to access the same repository.

14 Connect to the Oracle Warehouse Builder Repository using the Oracle Warehouse Builder Design Center application (installed as part of the Oracle Warehouse Builder installation).

### Configuring Oracle Warehouse Builder for the Customer Integration

This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To configure Oracle Warehouse Builder for the Customer Integration

1 Make sure the Oracle EBS database user to be used for Customer Initial Load has appropriate database access granted as listed below.

<table>
<thead>
<tr>
<th>Table or View Name</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>EGO_ITEM_SYNC_V</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_CONTACT_POINTS</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_CUST_ACCOUNTS</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_GEOGRAPHIES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_GEOGRAPHY_IDENTIFIERS</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_LOCATIONS</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_ORG_CONTACTS</td>
<td>Read</td>
</tr>
</tbody>
</table>
2 In the design center, navigate to Design > Import > Warehouse Builder Metadata, and import
the file named, CRMINTG_XFER_ORGS_TO_OD.mdl.

This creates a project named, CRMINTG_XFER_ORGS_TO_OD.

3 In this project, choose Experts, and then CRMINTG_CUST_XFER_XPRT,
DO_DEPLOY_AFTER_IMPORT.

4 To start the configuration and deployment of Oracle Warehouse Builder Design, right-click and
then choose Start.

5 Complete the resulting prompts for implementation-specific information such as your Oracle
E-Business Suite database, Oracle Warehouse Builder Repository database, and so on.

After successful completion, Oracle Warehouse Builder displays a confirmation message that
contains the steps needed to export the data.

To configure Oracle Warehouse Builder for the Product Integration

1 In Design Center, navigate to Design > Import > Warehouse Builder Metadata, and import the
file named, CRMINTG_PRODUCT_LOAD_OD.mdl.

This creates a project named, CRMINTG_PRODUCT_LOAD_OD.

2 In this project, choose Experts > CRMINTG_PRODUCT_EXPERT_MODULE >
CRMINTG_PRODUCT_EXPERT.

3 To start the configuration and deployment of Oracle Warehouse Builder Design, right click and
then choose Start.

4 Complete the resulting prompts for implementation-specific information, such as your Oracle
E-Business Suite database, Oracle Warehouse Builder Repository database, and so on.

5 Close any windows opened as part of this procedure.

After successful completion, Oracle Warehouse Builder displays a confirmation message that contains
the steps needed to export the data.

<table>
<thead>
<tr>
<th>Table or View Name</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>HZ_ORGANIZATION_PROFILES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_ORIG_SYS_REFERENCES</td>
<td>Read/Write</td>
</tr>
<tr>
<td>HZ_ORIG_SYSTEM_REF_S</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_PARTIES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_PARTY_SITE_USES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_PARTY_SITES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_PERSON_PROFILES</td>
<td>Read</td>
</tr>
<tr>
<td>HZ_RELATIONSHIPS</td>
<td>Read</td>
</tr>
</tbody>
</table>
Configuration Changes for Customer Data

This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

The following configuration changes in Oracle E-Business Suite affect the customer data integration:

- Users and Responsibilities on page 44
- Data Synchronization Profile Options on page 45
- Running the Concurrent Program on page 46
- Setting Up Data Quality Management Options on page 46

Users and Responsibilities

Assign an existing Oracle HTML Quoting user the “Siebel CRM On Demand User” responsibility. Only this user is able to log in and access the custom UI pages that are invoked from Siebel CRM On Demand.

The set up for a quoting user is a prerequisite. For more information, see the appropriate sections of the Oracle E-Business Suite Quoting Implementation Guide.

Creating a Synchronization Account

This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To perform synchronization of account, address, and contact information from Siebel CRM On Demand to Oracle E-Business Suite, a new user account is required on the Oracle E-Business Suite installation. Changes to data on Oracle E-Business Suite are performed using this new user account.

To create a synchronization account

2. Enter "User Name" = "ON_DEMAND_INT"
3. Specify a password for the synchronization account.
4. Assign the responsibility, Siebel CRM On Demand User, and save it.
### Data Synchronization Profile Options

Table 7 lists the profile options and their appropriate levels that need to be set to enable data synchronization from Oracle E-Business Suite to Siebel CRM On Demand.

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Purpose</th>
<th>Value</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siebel CRM On Demand Integration Account WSDL Location</td>
<td>New account custom UI calls BPEL process at this location.</td>
<td>Endpoint location for BPEL process CRMIntegCreateOrgSEBLOD11ToEBS11i10Sync</td>
<td>Site</td>
</tr>
<tr>
<td>Siebel CRM On Demand Integration Contact WSDL Location</td>
<td>New contact custom UI calls BPEL process at this location.</td>
<td>Endpoint location for BPEL process CRMIntegCreateContSEBLOD11ToEBS11i10Sync</td>
<td>Site</td>
</tr>
<tr>
<td>Siebel CRM On Demand Integration Lead WSDL Location</td>
<td>Converts Lead custom UI calls BPEL process at this location.</td>
<td>Endpoint location for BPEL process CRMIntegCreateOptySEBLOD11Sync</td>
<td>Site</td>
</tr>
<tr>
<td>HZ: Format Business Object Business Events as Bulk</td>
<td>For Data Synchronization from Oracle E-Business Suite to Siebel CRM On Demand.</td>
<td>No</td>
<td>Site</td>
</tr>
<tr>
<td>HZ: Execute API Callouts</td>
<td>For Data Synchronization from Oracle E-Business Suite to Siebel CRM On Demand.</td>
<td>All Events Enabled</td>
<td>Site</td>
</tr>
<tr>
<td>Oracle Applications Look and Feel</td>
<td>Sets the style sheet for a custom UI similar to Siebel CRM On Demand.</td>
<td>Siebel CRM On Demand Look and Feel</td>
<td></td>
</tr>
<tr>
<td>Siebel CRM On Demand Host Location</td>
<td>Used to build the Cancel button URL for custom pages.</td>
<td>A URL similar to: <a href="https://secure-ausomxa%D1%84%D0%B0.crmondemand.com">https://secure-ausomxaфа.crmondemand.com</a> Notice there is no &quot;/&quot; at the end.</td>
<td></td>
</tr>
</tbody>
</table>
Running the Concurrent Program
To enable data synchronization from Oracle E-Business Suite to Siebel CRM On Demand, run the concurrent program named, TCA Business Object Events: Raise Events Program with the appropriate responsibility (for example, Trading Community Manager). This program raises Trading Community Architecture BES Events for Business Objects. It applies to Create and Updated to customer data in Oracle E-Business Suite. Schedule it for intervals that are appropriate to your customer data create and update volume.

Setting Up Data Quality Management Options
To prevent duplicate records from occurring, the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite includes a Duplicate Prevention workflow. To set up the Data Quality Management (DQM) options, use the list in Table 8. The values in this table are suggestions, you can modify them for your specific environment. For more information on these profiles and their values, see DQM Administration Guide.

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Purpose</th>
<th>Value</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>HZ: Enable DQM Party Search</td>
<td>Required to Enable DQM</td>
<td>Yes</td>
<td>Responsibility: Siebel CRM On Demand User</td>
</tr>
<tr>
<td>HZ: Enable Duplicate Prevention at Party Creation</td>
<td>To enable duplication prevention at the time of party creation</td>
<td>Person and Organization</td>
<td>Responsibility: Siebel CRM On Demand User</td>
</tr>
<tr>
<td>HZ: Match Rule for Organization Duplicate Prevention</td>
<td>Match Rule to be used for Organization Duplicate Prevention</td>
<td>HZ_ORG_SIMPLE_SEARCH_RULE</td>
<td>Responsibility: Siebel CRM On Demand User</td>
</tr>
<tr>
<td>HZ: Match Rule for Person Duplicate Prevention</td>
<td>Match Rule to be used for Person Duplicate Prevention</td>
<td>HZ_PERSON_SIMPLE_SEARCH_RULE</td>
<td>Responsibility: Siebel CRM On Demand User</td>
</tr>
</tbody>
</table>

Configuring Changes for Product Data
This is a step in the Process of Configuring the Oracle E-Business Suite Environment on page 41.

To configure Oracle E-Business Suite for the product data synchronization, complete the following tasks:

- Assign the responsibility, Inventory, to each user.
Verify that the BPEL processes for Product synchronization are deployed on the BPEL server. Table 9 lists these processes.

Table 9. BPEL Processes for Product Synchronization

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRMIntegProductUpsetEBS11iToSEBLODAsync</td>
<td>Transforms the product from the common object schema to the Siebel CRM On Demand Schema</td>
</tr>
<tr>
<td>CRMIntegProductUpsetInterface</td>
<td>Initiates the Siebel CRM On Demand Web service API</td>
</tr>
<tr>
<td>CRMIntegSubscribeToBulkloadProductEBS11i10ToSEB782</td>
<td>Subscribes to oracle.apps.ego.item.postItemBulkload event and initiates the synchronization process</td>
</tr>
<tr>
<td>CRMIntegSubscribeToCreateProductEBS11i10ToSEB782</td>
<td>Subscribes to oracle.apps.ego.item.postItemCreate event and initiates the synchronization process</td>
</tr>
<tr>
<td>CRMIntegSubscribeToUpdateProductEBS11i10ToSEB782</td>
<td>Subscribes to oracle.apps.ego.item.postItemUpdate event and initiates the synchronization process</td>
</tr>
<tr>
<td>CRMIntegSyncProductEBS11i10ToSEB782Async</td>
<td>Main Item Sync Process; This queries ego_item_sync_v and prepares a payload for On Demand (Master Items alone). This payload is transformed to CO schema. This payload is passed over to Siebel services for Siebel CRM On Demand.</td>
</tr>
<tr>
<td>CRMIntegXformProductODORCommonEBS11i10ToSEB782</td>
<td>Transforms the payload from the Oracle schema to the common object schema</td>
</tr>
</tbody>
</table>

Configuring for Quoting Integration

To configure Oracle E-Business Suite for the Quoting Integration, complete these tasks:

- Implementing the Siebel CRM On Demand Look-and-Feel on page 47
- ASO: Auto Account Creation Profile on page 48
- ASO: On Demand Integration URL Profile on page 48
- Preventing Navigation Issues on Quote Related Pages on page 49

Implementing the Siebel CRM On Demand Look-and-Feel

Implementing the Siebel CRM On Demand Look-And-Feel is optional. It does not affect the ability to access the quote listing pages, it affects only how these pages render on the screen.
To enable the Siebel CRM On Demand look-and-feel on the related Oracle E-Business Suite quote listing pages, you must include the style classes defined in the following paragraph within a copy of the jtfcss.css style sheet that ships with the Oracle E-Business Suite (for example: oducss.css). These style classes must also be included in a copy of the jtfcss_med.css and jtfcss_sml.css (for example: oducss_med.css and oducss_sml.css). Set the profile JTF_PROFILE_DEFAULT_CSS to the newly copied style sheet (for example: oducss.css). For this change to take effect you must restart the Oracle E-Business Suite Middle Tier.

Make a copy of the original jtfcss.css file, rename the copied file and set the JTF_PROFILE_DEFAULT_CSS to the newly copied style sheet. This preferable to directly modifying the jtfcss.css file directly, as changes are not preserved during patching or upgrades under this approach.

The style classes to be included in the copy of jtfcss.css are:

```css
.SblTableTitlebar { background-color: #6689c2; font-family: tahoma, sans-serif; font-size: 8pt; font-weight: bold; padding: 5px 10px 5px 10px; border: 1px solid; border-color: #8ca6d1 #41639d #41639d #8ca6d1; color: #fff}

.SblTableAlphaFilterBar {background-color: #b2c2df;font-family: tahoma, sans-serif; font-size: 8pt; padding: 1px 5px 1px 5px}

.SblTableHeaderCell { background-color: #ced4dd; font-family: tahoma, sans-serif; font-size: 8pt; font-weight: bold; line-height: 12pt; padding: 1px 5px 1px 5px; text-align: left; white-space: wrap }

.SblTableDataCell { background-color: #f7f7e7; font-family: tahoma, sans-serif; font-size: 8pt; padding: 1px 5px 1px 5px; text-align: left }

.SblPageTitle { font-family: tahoma, sans-serif; display: inline; font-size: 11pt; font-weight: bold; margin: 0 10px 0 2px}

.SblTableRecordNav { font-family: tahoma, sans-serif; font-size: 8pt}
```

**ASO: Auto Account Creation Profile**

Set the ASO: Auto Account Creation profile to “As Required” or “Place Order”. This setting affects the Siebel CRM On Demand opportunity conversion for those opportunities that have a customer with more than one account associated with it. The resulting behavior is an Oracle E-Business Suite quote created for the customer without an account defaulted during the opportunity-to-quote conversion process. Users need to manually associate an account with the customer when updating the quote.

**ASO: On Demand Integration URL Profile**

Set the “ASO: On Demand Integration URL” profile to the On Demand Opportunity Product Line Query process on the BPEL Process Manager Server using this format:

```
http(s)://yourbpelserver.com:7777/orabpel/default/
CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync/1.0
```

For example: http(s)://www.yourcompany.com:7777/orabpel/default/
CRMIntegOpptunityProductLineQueryEBS11i10toSEBLODSync/1.0
The bold text in the previous URLs is environment specific and is the default location for the process on the BPEL Process Manager Server. The location might vary depending on how the process is deployed at your site.

Preventing Navigation Issues on Quote Related Pages

To prevent navigating to an unexpected page when accessing the quote related pages (Quote Listing for Accounts, Opportunity or the Sales Rep), complete the following task.

To configure navigation

1. Log in as a system administrator.
3. Query for the responsibility to be assigned to users for accessing the Oracle HTML Quoting module (such as Oracle HTML Quoting Sales Agent), and make a note of the responsibility key (such as HTML_QUOTING_SALES_AGENT).
4. Run the following jsp:
   ```
   http(s)://<server:port>/OA_HTML/qotSSbcJfnToken.jsp?qotRespKey=<Responsibility Key>
   ```
   Example:
   ```
   http(s)://yourEBSserver.com:7777/OA_HTML/
   qotSSbcJfnToken.jsp?qotRespKey=HTML_QUOTING_SALES_AGENT
   ```
   The jfn token parameter is generated.
5. Copy the jfn token parameter, and append it to the following two Web link URLs, replacing <jfn> with the jfn token parameter, which was generated in the previous step:
   ```
   http(s)://yourEBSserver.com:7777/OA_HTML/
   qotSSbpCreate.jsp?qotSblOptyId=%%%Id%%%&qotOptyNm=%%%Name%%%&jfn=<jfn>
   ```
   ```
   http(s)://yourEBSserver.com:7777/OA_HTML/
   qotSZzdPopup.jsp?qot FrmDspFile=qotSSbcOptyQuotes.jsp&qotOptyId=%%%Id%%%&qotOptyNm=%%%Name%%%&jfn=<jfn>
   ```
   **NOTE:** These URLs are required for the following configuration tasks: "Creating Web Tabs" on page 50 and "Creating Web Links" on page 51.
6. Complete the task "Creating Web Tabs" on page 50, and then return to this procedure.
   **NOTE:** The following step cannot be successfully completed until the following task ("Creating Web Tabs" on page 50) is done.
7. Test the configuration:
   a. Log in to Siebel CRM On Demand.
   b. Navigate to the Quotes Tab.
Enter the Oracle E-Business Suite username and password for the Sales Rep.

If successful, Siebel CRM On Demand displays the Quote Listing page, listing all quotes associated with the Sales Rep.

**NOTE:** This step can only be done after completing the Web Tab setup described on page 58.

### Process of Configuring the Siebel CRM On Demand Environment

To configure Siebel CRM On Demand, complete the following tasks:

- Creating Web Tabs on page 50
- Creating Web Links on page 51
- Modifying Layouts on page 53
- Creating Custom Fields on page 55
- Modifying Roles on page 55
- Modifying Pick Lists on page 57
- Changing Themes on page 58
- (Optional) Setting Up the Client-Side Browser on page 58

#### Creating Web Tabs

This is a step in [Process of Configuring the Siebel CRM On Demand Environment on page 50](#).

You need to create three custom Web tabs for these pages: the Account Create page, the Create Contact page, and the Quotes page. Follow these guidelines to create those Custom Web Tabs. This is a general guideline only, refer to the Siebel CRM On Demand documentation for the exact steps and details. Table 10 contains the display names and URLs for Web tab creation.

<table>
<thead>
<tr>
<th>Display Name</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Create</td>
<td>http(s)://&lt;host&gt;:&lt;port&gt;/OA_HTML/OA.jsp?OAFunc=IMC_SOD_ACCOUNT_CR&amp;OwnerUserId=%%%Useralias%%%</td>
</tr>
</tbody>
</table>
To create Web tabs
1 Log in as the Siebel CRM On Demand company administrator.
2 Navigate to Admin > Application Customization > Custom Web Tabs
3 Click New.
4 Specify the name to be displayed on the new Web Tab.
5 In the URL field enter: <<above>>

Creating Web Links
This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.
Perform the following steps using the data from Table 11. The URL must be entered exactly as it is shown in Table 11. The other fields are recommendations only.
These Web link fields are displayed as hyperlinks even in New Account, Contact, and Lead screens. For a successful synchronization of data between Oracle E-Business Suite and Siebel CRM, the user must click the Web link hyperlinks after the account, contact, or lead is saved in Siebel CRM On Demand.

To create Web links
1 Log in as the Siebel CRM On Demand company administrator.
2 Navigate to Admin > Application Customization > Object > Object Field Setup Page.
3 Click New Custom Field.
4 Specify the Display Name, set the Field Type to Web Link, and click Save.
5 Locate the newly added custom field and click the Edit Web Link.
6 Set the values as described in Table 11, and save the data.
Some URLs listed in Table 11 require a jfn token. For information on generating a jfn token, see Preventing Navigation Issues on Quote Related Pages on page 49.

Table 11. Web Link Options

<table>
<thead>
<tr>
<th>Object</th>
<th>Display Name</th>
<th>Display Text</th>
<th>Launch Behavior</th>
<th>Target Custom Web Tab</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>View Quotes</td>
<td>View Quotes for an account</td>
<td>Open in Custom Web Tab</td>
<td>Quotes</td>
<td>http(s)://&lt;host&gt;:&lt;post&gt;/OA_HTML/qotSZzdPopup.jsp?qotFrmDspFile=qotSSbcAcctQuotes.jsp&amp;qotHdrPtyId=% %%External_System_Id%%%&amp;qotHdrPtyNm=%%%Name%%%&amp;jfn=&lt;&lt;jfn token &gt;&gt;</td>
</tr>
<tr>
<td>Account</td>
<td>360 View</td>
<td>360 degree view of account</td>
<td>Open in New Window</td>
<td>Not applicable</td>
<td>http(s)://&lt;host&gt;:&lt;post&gt;/OA_HTML/OA.jsp?OAFunc=IMC_SOD_360_VIEW&amp;ImcPartyId=% %%External_System_Id%%%&amp;ImcPartyName=%%%Name%%%</td>
</tr>
<tr>
<td>Account</td>
<td>Create New Account</td>
<td>Create New Account</td>
<td>Open in Custom Web Tab</td>
<td>Account Create</td>
<td>http(s)://&lt;host&gt;:&lt;post&gt;/OA_HTML/OA.jsp?OAFunc=IMC_SOD_ACCOUNT_CR&amp;OwnerUserId=%%%User alias%%%</td>
</tr>
<tr>
<td>Activity</td>
<td>Account Merge</td>
<td>Account Merge</td>
<td>Open in New Window</td>
<td>Not applicable</td>
<td>http(s)://&lt;CRM OnDemand Server URL&gt;/OnDemand/user/AccountMergeWizard?OMTGT=Merge Wizard&amp;OMTHD=Merge Wizard&amp;Merge Wizard.Step1.SS_Id=%%%Account_Id%%%</td>
</tr>
<tr>
<td>Activity</td>
<td>Contact Merge</td>
<td>Contact Merge</td>
<td>Open in New Window</td>
<td>Not applicable</td>
<td>http(s)://&lt;CRM OnDemand Server URL&gt;/OnDemand/user/ContactMergeWizard?OMTGT=Merge Wizard&amp;OMTHD=Merge Wizard&amp;Merge Wizard.Step1.SS_Id=%%%Contact_Id%%%</td>
</tr>
</tbody>
</table>
Modifying Layouts

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

To modify layouts, perform the following task, using Table 12 as a guide.

Table 11. Web Link Options

<table>
<thead>
<tr>
<th>Object</th>
<th>Display Name</th>
<th>Display Text</th>
<th>Launch Behavior</th>
<th>Target Custom Web Tab</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Convert Lead</td>
<td>Convert Lead to Opportunity</td>
<td>Open in Custom Web Tab</td>
<td>Account Create</td>
<td>http(s)://&lt;host&gt;:&lt;port&gt;/OA_HTML/OA.jsp?OAFunc=IMC_SOD_CONVERT_LEAD&amp;leadId=%%%Id%%%&amp;OwnerUserId=%%%Useralias%%%&amp;leadActName=%%%Company_Name%%%&amp;optyName=%%%First_Name%%%&amp;%20%%%Last_Name%%%&amp;optyNext=%%%Next_Step%%%&amp;optyDesc=%%%Description%%%&amp;optyRev=%%%Potential_Revenue%%%&amp;optyClose=%%%Estimated_Close_Date%%%&amp;optyId=%%%Opportunity_Id%%%&amp;leadContFname=%%%First_Name%%%&amp;leadContLname=%%%Last_Name%%%&amp;leadContPhone=%%%Work_Phone_#%%%&amp;leadContMobile=%%%Cellular_Phone_#%%%&amp;leadContFax=%%%Fax_Phone_#%%%&amp;leadContEmail=%%%E-mail_Address%%%</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Create Quote</td>
<td>Create Quote in EBS System</td>
<td>Open in Custom Web Tab</td>
<td>Quotes</td>
<td>http(s)://&lt;&lt;Oracle EBS Server Host Name&gt;&gt;://&lt;port&gt;://OA_HTML/qotSSbpCreate.jsp?qotSblOptyId=%%%Id%%%&amp;qotOptyNm=%%%Name%%%&amp;jfn=&lt;jfn token &gt;&gt;</td>
</tr>
<tr>
<td>Opportunity</td>
<td>View Quotes</td>
<td>View Quotes for the Opportunity.</td>
<td>Open in Custom Web Tab</td>
<td>Quotes</td>
<td>http(s)://&lt;host&gt;:&lt;port&gt;/OA_HTML/qotSZzdPopup.jsp?qotFrmDspFile=qotSSbcOptyQuotes.jsp&amp;qotOptyId=%%%Id%%%&amp;qotOptyNm=%%%Name%%%&amp;jfn=&lt;jfn token &gt;&gt;</td>
</tr>
<tr>
<td>Contact</td>
<td>Create New Contact</td>
<td>Create New Contact</td>
<td>Open in Custom Web Tab</td>
<td>Contact Create</td>
<td>http(s)://&lt;host&gt;:&lt;port&gt;/OA_HTML/OA.jsp?OAFunc=IMC_SOD_CONTACT_CR&amp;OwnerUserId=%%%Useralias%%%</td>
</tr>
</tbody>
</table>
To modify layouts
1. Log in as the Siebel CRM On Demand company administrator.
2. Navigate to Admin > Application Customization > [Object] > [Object] Layout, where [Object] is an object listed in Table 12.
3. Click either Select New Layout or Edit an existing Layout.
4. For new layouts, set the Name.
5. On the Field Setup step, set the appropriate fields to read only, as shown in Table 12.
6. On the Field Layout step, add the listed fields to the Layout.
7. On The Related Information step, add the items in Table 12 to the Displayed Information section.
8. Click Finish.
10. Click Edit for the roles to assign new layout.
11. Navigate to Page Layout Assignment and assign the new layout to the Role.

Table 12. Layout Settings

<table>
<thead>
<tr>
<th>Object</th>
<th>Layout Name</th>
<th>Role</th>
<th>Read-Only Fields</th>
<th>Layout Fields</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Account FSR Layout</td>
<td>Field Sales Rep</td>
<td>Location</td>
<td>All Account Web Links created in &quot;Creating Web Tabs&quot; on page 50.</td>
<td>Addresses</td>
</tr>
<tr>
<td>Lead</td>
<td>Lead FSR Layout</td>
<td>Field Sales Rep</td>
<td>N/A</td>
<td>All Lead Web Links created in &quot;Creating Web Tabs&quot; on page 50.</td>
<td></td>
</tr>
<tr>
<td>Contact</td>
<td>Contact FSR Layout</td>
<td>Field Sales Rep</td>
<td>Account</td>
<td>All Contact Web Links created in &quot;Creating Web Tabs&quot; on page 50.</td>
<td>Addresses</td>
</tr>
<tr>
<td>Opportunity Product</td>
<td>Oppty Product FSR Layout</td>
<td>Field Sales Rep</td>
<td>Description</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Task Admin Layout</td>
<td>Admin</td>
<td></td>
<td>All Activity Web Link Fields created in the section above.</td>
<td></td>
</tr>
</tbody>
</table>
Creating Custom Fields

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Complete the following procedure to create custom fields needed by this integration.

To create custom fields
1. Log in as the Siebel CRM On Demand company administrator.
3. Click New Field.
4. Set the Display Name to EBS Status.
5. Confirm that the Integration tag is set to stEBS_Status.
6. Set the Field Type to Text (Short), and click Save.

Modifying Roles

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Complete the following procedure to modify roles as needed by this integration.

To modify roles
1. Log in as the On Demand Company System Administrator.
   TIP: Copy the Default and Owner Access profiles and edit the copy.
3. Click either New or Edit.
4. Edit the copied Field Sales Rep Default Access Profile.
   a. Navigate to Step 2 - Specify Access Levels.
   b. Set the following values:
      • Account Access Level to Read/Edit
      • Account Related Information, Address Account Default Access to Read/Create/Edit.
      • Contact Default Access to Read/Edit.
      • Contact Related Information, Address Contact Default Access to Read/Create/Edit.
   c. Click Finish.
5. Edit the copied Field Sales Rep Owner Access Profile.
   a. Navigate to Step 2 - Specify Access Levels.
   b. Set the following values:
Installing and Configuring the Applications

Process of Configuring the Siebel CRM On Demand Environment

- Account Access Level to Read/Edit.
- Account Related Information, Address Account Owner Access to Read/Create/Edit.
- Contact Owner Access to Read/Edit.
- Contact Related Information, Address Contact Owner Access to Read/Create/Edit.
  - Click Finish.

6 Navigate to Admin > User Management & Access Controls > Role Management.
7 Either select an existing Role or create a new Role by clicking New Role.
8 On Step 2 – Record Type Access page, complete the following:
   - Make sure the Has Access and Can Read All Records check boxes are checked for Account and Contact Record Type Access.
   - Make sure the Can Create check box is clear for Account and Contact Record Type Access.
9 On Step 3 – Access Profiles, assign the Access Profile to the role.
10 On Step 4 – Privileges, clear the Convert Leads Privilege check box.
11 On Step 5 - Tab Access & Order, add the Create Contact, Create Account, and Quotes Tabs to the Selected Tabs section.
12 On Step 6 – Page Layout Assignment, select the corresponding Page Layout created for the Objects in Modifying Layouts on page 53.
13 Click Finish.

Enabling Web Services

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Enable Web services in Siebel CRM On Demand by doing the following procedure.

To enable Web services
1 Log in to Siebel CRM as a company administrator.
2 Navigate to Admin > Company Administration > Company Profile > Edit.
3 Check the Web Services Enabled check box.

Merging Records

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.
After a successful merge operation in Oracle E-Business Suite, an activity is created for the CRM On Demand company administrator, as specified in the CRMIntegSEBLODConfig.xml file. Because the Oracle E-Business Suite to Siebel CRM On Demand integration user has restricted access to account and contact data, only an company administrator can perform a successful merge operation in CRM On Demand. If Contacts are merged as part of the Account Merge process in Oracle EBS, on the surviving or master account there is no automatic removal of the merged Contacts. If as part of merge, new contacts need to be removed from the surviving account, that needs to be done manually by the system administrator or data librarian.

**Personal Information Manager Synchronization**

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

Because the Oracle E-Business Suite to Siebel CRM On Demand integration user has restricted access to account and contact data in Siebel CRM On Demand, this integration user cannot perform a successful Personal Information Manager (PIM) synchronization operation in Siebel CRM On Demand.

**Modifying Pick Lists**

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

**NOTE:** Complete modifying the pick lists before loading customer data from Oracle E-Business Suite to Siebel CRM On Demand.

**To modify pick lists**

1. Run the following query using SQLPLUS on the Oracle E-Business Suite instance, and add new entries to the “Mr./Ms.” Picklist (Application Layout / Contact Fields) with Siebel CRM On Demand:

   ```sql
   select lookup_code, meaning
   from fnd_lookup_values_vl
   where lookup_type = 'CONTACT_TITLE'
   and view_application_id = 222
   and enabled_flag = 'Y'
   and sysdate between start_date_active and nvl(end_date_active, sysdate + 1)
   ```

2. In Oracle E-Business Suite:

   ```sql
   Id = lookup_code
   Picklist Values = meaning
   ```

3. In Siebel CRM On Demand:

   ```sql
   Id = lookup_code
   Picklist Values = meaning
   ```

4. Also, if a new value is added to CONTACT_TITLE lookup on Oracle E-Business Suite, add the corresponding value to the Siebel CRM On Demand picklist.
**Changing Themes**

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite was designed with the "Classic" Siebel CRM On Demand theme in mind. By default the "Contemporary" theme is enabled. You can change the company theme "Classic" (recommended) by navigating to Admin > Company Administration > Company Profile > Company Theme setting.

**Optional** Setting Up the Client-Side Browser

This is a step in Process of Configuring the Siebel CRM On Demand Environment on page 50.

When a user navigates to an Oracle E-Business Suite page embedded within a custom tab, the browser might display the following message:

```
This page contains both secure and nonsecure items
Do you want to display the nonsecure items?
```

To prevent this, set your browser's security settings to enable the display of mixed content.

**To set browser security settings**

1. In Internet Explorer navigate to Tools > Internet Options > Security Tab > Local Intranet or Internet (depending on whether your Oracle E-Business Suite instance is deployed on the internet or on a local intranet).
2. Click Custom Level.
3. In the Miscellaneous section, select Enable for the Display Mixed Content option.

**About Using Customized Fields**

If you have modified Oracle E-Business Suite using Flex or Extension columns, be aware that these columns cannot be directly transferred to Siebel CRM On Demand. Because Siebel CRM On Demand is implemented in a hosted environment, no customization of these fields is possible.

It is possible to modify the transformation maps. This is at your own risk, so make sure to make a backup copy of the transformation map before attempting any editing. The transformation maps are:

- For Oracle E-Business Suite to Siebel CRM On Demand, the map file is: CRMIntgXformEBS11i10OrgToSEBLOD11Account.xsl.
- For Siebel CRM On Demand to Oracle E-Business Suite, the map file is: CRMIntgXformSEBLOD11AccountToEBS11i10Org.xsl.
This chapter describes how to bulk load data from Oracle E-Business Suite into Siebel CRM On Demand. Bulk loading is necessary for the initial load, but can be done at any time if needed. This chapter contains the following sections:

- "Bulk Loading of Customer and Contact Data" on page 60
- "Bulk Loading of Product Data" on page 61
- "Process of Importing CSV Files into Siebel CRM On Demand” on page 62
Bulk Loading of Customer and Contact Data

Bulk loading of customer and contact data is required when preparing to use the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. Bulk loading can also be used at a later date to move large amounts of customer data, for example, after a purchase of customer data or an acquisition made by the implementing organization. Bulk loading is a one-way process. Data is extracted from Oracle E-Business Suite and imported into Siebel CRM On Demand. Figure 3 illustrates the high-level solution for a customer data bulk load.

The Siebel CRM On Demand Data Import infrastructure can import data that is in CSV format. Data extracted using Oracle Warehouse Builder must generate four CSV files, each one containing the following information:

- accounts (organization parties)
Initial Bulk Loading of Customer, Contact, and Product Data

Bulk Loading of Product Data

- account addresses
- contact addresses
- Organization contacts

Active organization parties that have at least one active account must export the following data:

- Organization contacts
- Active organization party addresses
- Active contact addresses

Organization parties and organization contacts that are associated with an account in Oracle E-Business Suite must be synchronized with Siebel CRM On Demand.

**To bulk load customer data by generating CSV files**

1. Make sure you have completed “To configure Oracle Warehouse Builder for the Customer Integration” on page 42.
2. Navigate to Tools > Control Center Manager.
3. Navigate to CRMINTG_XFER_ORGS_TO_OD > CRMINTG_OWB_REPOS_LOC > CRMINTG_OWB_REPOS_MODULE > Mappings.
4. Right-click the CRMINTG_1_ACCT_N_ADDR_TO_FILES map, and choose Start.
   The Accounts.csv and Account_addr.csv files are generated in the directory that was specified during the execution of the CRMINTG_CUST_XFER_XPRT->DO_DEPLOY_AFTER_IMPORT expert.
5. Wait for the process to complete successfully.
6. Right-click the CRMINTG_2_ACCT_CR_XREF_IN_EBS map, and choose Start.
   This process populates the cross-reference information in the Oracle E-Business Suite database.
7. Wait for the process to complete successfully.
8. Right-click the CRMINTG_1_CONT_N_ADDR_TO_FILES map, and choose Start.
   The Contacts.csv and Contact_addr.csv files are generated in the directory that was specified during the execution of the CRMINTG_CUST_XFER_XPRT->DO_DEPLOY_AFTER_IMPORT expert.
9. Wait for the process to complete successfully.

**Bulk Loading of Product Data**

Bulk loading of product data is similar to that of bulk loading customer data. However, the product data load generates only one CSV file.

**To bulk load product data by generating CSV files**

1. Make sure you have completed “To configure Oracle Warehouse Builder for the Product Integration” on page 43.
2 Navigate to Tools > Control Center Manager.

3 Navigate to:
   CRMINTEG_PRODUCT_LOAD_OD > CRMINTEG_PRODUCT_OWB_LOCATION >
   CRMINTEG_PRODUCT_OWBREP_MODULE > Mappings > CRMINTEG_PRODUCT_EBS_TO_SEBL

4 Right-click the CRMINTEG_PRODUCT_OWBREP_MODULE map, and choose Start.
   The CRMINTEG_PRODUCT_EBS_TO_SEBL_OD.cs file is generated in the directory that was
   specified during the execution of the CRMINTEG_PRODUCT_EXPERT_MODULE -
   >CRMINTEG_PRODUCT_EXPERT.

5 Wait for the process to complete successfully.

**Process of Importing CSV Files into Siebel CRM On Demand**

The CSV files generated by Oracle Warehouse Builder must be loaded into Siebel CRM On Demand. Table 13 lists important information about the loading process. Some CSV files are loaded using the Siebel CRM On Demand import wizard, and some are loaded using the OnDemandAddressImport.exe executable.
Make sure the client machine running the Oracle Warehouse Builder client is set to the same language that is used for Siebel CRM On Demand.

### Table 13. Information about CSV File Loading Process

<table>
<thead>
<tr>
<th>Suggested Load Order</th>
<th>CSV File Name</th>
<th>Load Using</th>
<th>Load Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Accounts.csv</td>
<td>Siebel CRM On Demand Import Wizard</td>
<td>Load at any time. Suggestion: load this file first.</td>
</tr>
<tr>
<td>2</td>
<td>Contacts.csv</td>
<td>Siebel CRM On Demand Import Wizard</td>
<td>Load only after the accounts.csv file is successfully loaded.</td>
</tr>
<tr>
<td>3</td>
<td>Product.csv</td>
<td>Siebel CRM On Demand Import Wizard</td>
<td>Can be loaded at any time.</td>
</tr>
<tr>
<td>4</td>
<td>Account_addr.csv</td>
<td>Use OnDemandAddressImport.exe executable.</td>
<td>Load only after the accounts.csv file is successfully loaded.</td>
</tr>
<tr>
<td>5</td>
<td>Contact_addr.csv</td>
<td>Use OnDemandAddressImport.exe executable.</td>
<td>Load only after the contacts.csv file is successfully loaded.</td>
</tr>
</tbody>
</table>

**TIP:** A spreadsheet application (such as MS Excel, OpenOffice, and so on) that is used to open the CSV file generated from Oracle Warehouse Builder must have support for the character-set enabled on the Oracle Warehouse Builder repository. This requirement is primarily applicable to Multiple Language Sets installs. Table 1 on page 15 lists the supported character sets.

To complete this process, perform the following tasks:

1. Launching the Siebel CRM On Demand import Wizard on page 63
2. Using the Import Wizard on page 64
3. Configuring the CRMIntegSEBLODAddressLoader.exe.config File on page 64
4. Using the Address Import Executable on page 65

### Launching the Siebel CRM On Demand import Wizard

This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.
To launch the Siebel CRM On Demand import wizard
1. Log in with an account that has the privilege, Administration Import.
2. Navigate to the Admin Homepage.
3. Click Import and Export Tools.
4. Select the object type to Import.
   This launches the Import Wizard.

Using the Import Wizard
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

To use the import wizard
1. Accept the default options, and select a CSV file using the browse button.
2. Select the provided map file that maps the data in the CSV file to the default Siebel CRM On Demand Columns:
   - OnDemand_Account_Field_Mapping.map
   - OnDemand_Contact_Field_Mapping.map
   - OnDemand_Product_Field_Mapping.map
3. You can change the default mapping if desired.
   The wizard alerts you about any fields in your data file that were not mapped.

Configuring the CRMIntegSEBLODAddressLoader.exe.config File
This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

The CRMIntegSEBLODAddressLoader.exe.config file must be modified to map to the Siebel CRM On Demand server hosting your Siebel CRM On Demand CRM Application and the internet protocol used.

To configure the CRMIntegSEBLODAddressLoader.exe.config file
1. Open the CRMIntegSEBLODAddressLoader.exe.config file with a text editor.
2. Add a key for your Siebel CRM On Demand Server using the following format:
   `<add key="OnDemandServer" value="[server name]" />`
   Example:
   `<add key="OnDemandServer" value="secure-ausomxafa.crmondemand.com" />`
3 If you use an internet protocol other than https://, add a key for the internet protocol you use, in the following format:

```xml
<add key="InternetProtocol" value="[protocol name]"/>
```

Example:

```xml
<add key="InternetProtocol" value="Secure or Non Secure HTTP protocol"/>
```

**Using the Address Import Executable**

This is a step in Process of Importing CSV Files into Siebel CRM On Demand on page 62.

**To use the address import executable**

1. Make sure you have .NET Framework 1.1 or newer.
2. Launch the CRMIntegSEBLODAddressLoader.exe executable.
3. Indicate if this is an account address or contact address import.
4. Browse for the file containing the address data.
5. Click Import.
Initial Bulk Loading of Customer, Contact, and Product Data  ■ Process of Importing CSV Files into Siebel CRM On Demand
This chapter describes the integration points for contained in Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. It contains the following sections:

- Integration Assumptions on page 67
- Customer Data Integration on page 68
- Product Integration on page 84
- Quote Integration on page 86

Integration Assumptions

The following conditions are assumed to be present for this integration:

- Oracle E-Business Suite User Management Assumptions on page 67
- Customer Data Synchronization Assumptions on page 67
- Product Data Synchronization Assumptions on page 68

Oracle E-Business Suite User Management Assumptions

When a user logs in to Oracle E-Business Suite seamless navigation between the two applications is enabled. The user is prompted to log in to Oracle E-Business Suite when first attempting to access an Oracle E-Business Suite page. Subsequent visits to an Oracle E-Business Suite page do not require the user to log in. An automatic log-in between Siebel CRM On Demand and Oracle E-Business Suite by way of Single Sign-on is not provided in this integration.

The application user must have a user account on both Siebel CRM On Demand and Oracle E-Business Suite. The user profiles on each of the respective applications operate independently, with the expectation that language preferences and other user preferences and localizations are set up to be synchronized between the accounts. It is the user’s responsibility to manually maintain this synchronization. This synchronization is not provided in this integration.

Customer Data Synchronization Assumptions

The Siebel CRM On Demand Customer Master and the Oracle E-Business Suite Customer master are expected to be synchronized to enable the integration of Siebel CRM On Demand opportunity with quoting. Updates to Account and Contact records made by the Admin user specified in the CRMIntegSEBLODConfig.xml file are not pushed to the Oracle E-Business Suite. This is to avoid endless feedback looping updates to the Account and Contact records in the respective databases.
The integration assumes that Siebel CRM On Demand users have access to the Oracle E-Business Suite application either directly through the company intranet, VPN, or similar.

Product Data Synchronization Assumptions

The Siebel CRM On Demand Product Catalog and Oracle E-Business Suite Item Master are expected to be synchronized to enable the Siebel CRM On Demand opportunity product lines to be passed to Oracle E-Business Suite quoting. Product data are initially loaded into Siebel CRM On Demand using a bulk load. Subsequent changes or product additions in Oracle E-Business Suite are synchronized with Siebel CRM On Demand. All product information is maintained within Oracle E-Business Suite and synchronized with Siebel CRM On Demand.

Customer Data Integration

After the initial load of the Customer Data from Oracle E-Business Suite into Siebel CRM On Demand is complete, the customer records that exist in both applications are synchronized, so that data integrity is maintained. Customer data is synchronized whenever an existing customer record that exists in both applications is changed in either application or when a new customer record is created in Oracle E-Business Suite.

Synchronization Flows

The Customer Data integration consists of the following synchronizations:

- About Creating New Customers in Oracle E-Business Suite on page 68
- About Creating New Customers in Siebel CRM On Demand on page 69
- About Updating Existing Customers in Oracle E-Business Suite on page 74
- About Updating Existing Customers in Siebel CRM On Demand on page 75
- About Converting Leads on page 76
- About Integrating 360° View User Interface on page 77

You cannot create new customers directly in Siebel CRM On Demand, only update existing ones. Oracle E-Business Suite is the master for accounts and contacts, and as such new accounts and contacts must be created in Oracle E-Business Suite.

About Creating New Customers in Oracle E-Business Suite

When a new Customer Account record is created in Oracle E-Business Suite through any Oracle E-Business Suite product UI or Oracle E-Business Suite Public API, a new account is created in Siebel CRM On Demand. Any updates made to this customer account later in Oracle E-Business Suite or Siebel CRM On Demand are synchronized. New customer accounts created through bulk import processes in Oracle E-Business Suite are not synchronized with Siebel CRM On Demand.
Figure 4 illustrates the data synchronization flow used when a new customer record is created in Oracle E-Business Suite.

**About Creating New Customers in Siebel CRM On Demand**

New customer data in Siebel CRM On Demand is created through a Create Account or Create Contact Oracle E-Business Suite application page deployed within the Oracle E-Business Suite middle tier (on premise) and made available in Siebel CRM On Demand using a Web link custom tab. You must disable the existing links to the standard Create Account or Create Contact functionality in the Siebel CRM On Demand User Interface.

New customer data in Siebel CRM On Demand is created using an Oracle E-Business Suite Create Account page or Create Contact page embedded within a Siebel CRM On Demand custom tab. The existing Create Account or Create contact functionality within the Siebel CRM On Demand user interface is disabled as part of the configuration steps. For more information on disabling these privileges, see Modifying Roles on page 55.
When an Siebel CRM On Demand user creates a new account or contact, the user is redirected to the Create Account or Create Contact application User Interface (UI) page. Figure 5 shows an example of the Create New Account page. This application UI page has the look and feel of the standard Siebel CRM On Demand User Interface.

Figure 5. The Create New Account Page
Figure 6 shows an example of the Create New Contact page. This page differs from the standard Siebel CRM On Demand Create New Contact page in that the Account section has been removed. This section is not required, because in Siebel CRM On Demand, it is a read-only section and displays the primary billing address of the Account by default.
When the new record is saved it invokes a process flow that creates the new record in both Oracle E-Business Suite and Siebel CRM On Demand as illustrated in Figure 7.

Figure 7. Create New Customers in Siebel CRM On Demand—Synchronization Flow
Figure 8 provides more details on this synchronization flow.
About Updating Existing Customers in Oracle E-Business Suite

Figure 9 illustrates the data synchronization flow when an existing customer record is updated in Oracle E-Business Suite. This flow is very similar to creating a new customer record. When a relevant, existing customer record is updated in Oracle E-Business Suite, the updated customer record is synchronized with Siebel CRM On Demand.

Only newly created or updated Oracle organization parties and organization contacts that are associated with an account in Oracle E-Business Suite need to be synchronized with Siebel CRM On Demand. Persons Parties (no matter if they are associated with an account in Oracle or not) that do not have a relationship with an organization do not need to be synchronized.
**About Updating Existing Customers in Siebel CRM On Demand**

Siebel CRM On Demand can detect changed customer records, but it does not have the capability of publishing these changes in real-time. Siebel CRM On Demand is not capable of initiating the synchronization flow. A BPEL process polls the Siebel CRM On Demand audit tables to discover these updates. This process calls another BPEL process to synchronize the updates for account and contacts. Figure 10 illustrates this flow.

![Figure 10. Update an Existing Customer in Siebel CRM On Demand - Synchronization Flow](image)

Only updated Siebel CRM On Demand accounts and account contacts need to be synchronized with Oracle E-Business Suite. Updates to stand-alone contacts (without a relationship with an account) are not synchronized. Only updates to Siebel CRM On Demand accounts and account contacts that exist in Oracle E-Business Suite need to be synchronized.
About Converting Leads

For the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite to work, an opportunity in Siebel CRM On Demand must be associated with an existing account. This is not a requirement in standard Siebel CRM On Demand. As part of the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, a Convert Lead to Opportunity page is deployed within the Oracle E-Business Suite middle tier (on premise) and made available in Siebel CRM On Demand using a Web link. When an Siebel CRM On Demand user clicks the Convert Lead link in Siebel CRM On Demand, the user is directed to a specialized page that converts the lead into an opportunity. To make the transition seamless this page has the look and feel of the standard Siebel CRM On Demand User Interface. Figure 11 shows an example of this page.

The relevant fields from the Lead Detail page are displayed by default on the Convert Lead page. You can associate an account with this lead either by choosing an existing account from the Account LOV, or by entering a new account name. You can optionally create an opportunity from this lead.
Figure 12 illustrates the process and data flow that are executed when the process, Create Lead to Opportunity, is started from the custom Convert Lead page.

Figure 12. Process Flow for Converting an Siebel CRM On Demand Opportunity to an Oracle E-Business Suite Quote

About Integrating 360° View User Interface

A user interface (UI) page is in the Oracle Customer Online application of Oracle E-Business Suite. This UI page displays all transactions for a customer, such as invoices, orders, quotes, service requests, and so on. It is known as the 360° View, because it provides a full view of all of the customer’s transactions. This 360° Transaction View page of the Oracle Customer Online application is exposed in the Siebel CRM On Demand user interface as a global link, or in a global link custom tab, so that an Siebel CRM On Demand user can also get a full view of all of the customer’s transactions. It opens in a separate browser window.
Figure 13 illustrates the 360° View.

**Business World : Transactions**

You may select a particular transaction type to view a specific transaction history or click on List View button to see a complete list of business transactions.

**Events**

<table>
<thead>
<tr>
<th>Name</th>
<th>Item ID</th>
<th>Event Type</th>
<th>Source Code</th>
<th>Start Date</th>
<th>End Date</th>
<th>Group</th>
<th>Involved</th>
<th>Modified</th>
<th>Attached</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customer Events</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Events</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Customer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Existing Customer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Quotes**

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Account Description</th>
<th>Route Name</th>
<th>Route Number</th>
<th>Contact Name</th>
<th>Status</th>
<th>Primary Salesperson</th>
<th>Creation Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>Bill</td>
<td>12524</td>
<td>Jones, Mrs, Lisa</td>
<td>Draft</td>
<td>John Doe</td>
<td>25-NOV-2006</td>
<td>$1,000 USD</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>Bill</td>
<td>12524</td>
<td>Jones, Mrs, Lisa</td>
<td>Draft</td>
<td>John Doe</td>
<td>25-NOV-2006</td>
<td>$1,000 USD</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>Bill</td>
<td>12523</td>
<td>Jones, Mrs, Lisa</td>
<td>Draft</td>
<td>John Doe</td>
<td>25-NOV-2006</td>
<td>$1,000 USD</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>Bill</td>
<td>12523</td>
<td>Jones, Mrs, Lisa</td>
<td>Draft</td>
<td>John Doe</td>
<td>25-NOV-2006</td>
<td>$1,000 USD</td>
</tr>
</tbody>
</table>

**Orders**

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Customer Name</th>
<th>Sales Order</th>
<th>Customer PO</th>
<th>Order Type</th>
<th>Category</th>
<th>Date Ordered</th>
<th>Requested Ship Date</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>12524</td>
<td>12524</td>
<td>Order only</td>
<td>Order</td>
<td>02-APR-2002</td>
<td>02-APR-2002</td>
<td>Closed</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>12524</td>
<td>12524</td>
<td>Order only</td>
<td>Order</td>
<td>02-APR-2002</td>
<td>02-APR-2002</td>
<td>Closed</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>12524</td>
<td>12524</td>
<td>Order only</td>
<td>Order</td>
<td>02-APR-2002</td>
<td>02-APR-2002</td>
<td>Closed</td>
</tr>
<tr>
<td>1AAB</td>
<td>Business World</td>
<td>12524</td>
<td>12524</td>
<td>Order only</td>
<td>Order</td>
<td>02-APR-2002</td>
<td>02-APR-2002</td>
<td>Closed</td>
</tr>
</tbody>
</table>

Figure 13. The 360° View

**Customer Data Mappings**

The following topics describe how customer data is mapped between Oracle E-Business Suite and Siebel CRM On Demand:

- "Account Entity Attribute Mappings" on page 79
- Address Entity Attribute Mappings on page 80
- Contact Entity Attribute Mappings on page 82
# Account Entity Attribute Mappings

Table 14 lists the data mappings for account data.

Table 14. Data Mappings for Account Data

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Account Name. Indicates the name of the account</td>
<td>Text</td>
<td>100</td>
<td>Entity: Organization Attribute: organization_name Note: substr (100)</td>
</tr>
<tr>
<td>2</td>
<td>Account Currency</td>
<td>Picklist Pre-defined</td>
<td>15</td>
<td>Entity: Organization Attribute: pref_functional_currency</td>
</tr>
<tr>
<td>3</td>
<td>Location. Indicates the type of facility operated by the account at this site, such as Headquarters</td>
<td>Text</td>
<td>50</td>
<td>Entity: Organization Attribute: party_number Note: Siebel CRM On Demand does not synchronize this field back to CDH.</td>
</tr>
<tr>
<td>4</td>
<td>Web Site URL address for the account</td>
<td>Text</td>
<td>100</td>
<td>Entity: Contact Point Attribute: URL Note: Primary for contact_point_type = WEB. substr (100)</td>
</tr>
<tr>
<td>5</td>
<td>Public Company Indication that the account is a publicly owned company</td>
<td>Check box</td>
<td></td>
<td>Entity: Organization Attribute: public_private_ownership_flag</td>
</tr>
<tr>
<td>6</td>
<td>Annual Revenues Amount of the company's annual revenue</td>
<td>Number</td>
<td>15</td>
<td>Entity: Organization Attribute: curr_fy_potential_revenue</td>
</tr>
<tr>
<td>7</td>
<td>Description Additional information about the account</td>
<td>Text</td>
<td>1999</td>
<td>Entity: Organization Attribute: mission_statement</td>
</tr>
<tr>
<td>8</td>
<td>External Unique ID</td>
<td>Text</td>
<td>30</td>
<td>Entity: Organization Attribute: party_id Note: Trading Community Architecture's party_id for the organization</td>
</tr>
<tr>
<td>9</td>
<td>Furigana Name The Furigana equivalent of the Kanji (for Japanese only)</td>
<td>Text</td>
<td>100</td>
<td>Entity: Organization Attribute: organization_name_phonetic</td>
</tr>
</tbody>
</table>
### About Integrating Customer Data, Products, and Quotes

#### Customer Data Integration

**Address Entity Attribute Mappings**

Table 15 lists the data mappings for address data.

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>External Unique ID</td>
<td>Text</td>
<td>30</td>
<td>Entity: Contact Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: raw_phone_number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: Maps to the primary (or last</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>created if no primary) contact point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>where CONTACT_POINT_TYPE='PHONE' and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PHONE_LINE_TYPE!='FAX'.</td>
</tr>
<tr>
<td>2</td>
<td>Address 1</td>
<td>Text</td>
<td>200</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: address1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (200)</td>
</tr>
<tr>
<td>3</td>
<td>Address 2</td>
<td>Text</td>
<td>100</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: address2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (100)</td>
</tr>
<tr>
<td>4</td>
<td>Address 3</td>
<td>Text</td>
<td>100</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: address3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (100)</td>
</tr>
</tbody>
</table>
Table 15. Address Entity Attribute Mapping

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>City</td>
<td>Text</td>
<td>50</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: city</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (50)</td>
</tr>
<tr>
<td>6</td>
<td>Country</td>
<td>Picklist</td>
<td>30</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: country</td>
</tr>
<tr>
<td>8</td>
<td>Province</td>
<td>Text</td>
<td>50</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: province</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (50).</td>
</tr>
<tr>
<td>9</td>
<td>US State</td>
<td>Picklist</td>
<td>2</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: state</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: If the country value is US, then</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>populate the two-letter state code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For other countries, do not populate</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>this column, instead populate the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>province.</td>
</tr>
<tr>
<td>10</td>
<td>Billing Zip / Postal Code</td>
<td>Text</td>
<td>30</td>
<td>Entity: location</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: postal_code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (30)</td>
</tr>
<tr>
<td>11</td>
<td>Billing</td>
<td>Checkbox</td>
<td>N/A</td>
<td>Entity: Party Site Use</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: primary_per_type ()</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: If the site has a primary bill</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>to use, set this to Y, otherwise N.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Only for Account Address.</td>
</tr>
<tr>
<td>12</td>
<td>Shipping</td>
<td>Checkbox</td>
<td>N/A</td>
<td>Entity: Party Site Use</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: primary_per_type ()</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: If the site has a primary ship</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>to use, mark this Y, otherwise N.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Only for Account Address.</td>
</tr>
<tr>
<td>13</td>
<td>Primary</td>
<td>Checkbox</td>
<td>N/A</td>
<td>Entity: Party Site</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: identifying_flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: If the site has identifying_flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>= Y, mark Y, otherwise N.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Only for contact address.</td>
</tr>
</tbody>
</table>
### Table 15. Address Entity Attribute Mapping

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Contact External ID</td>
<td>Text</td>
<td>30</td>
<td>Entity: Party Attribute: party_id Note: Trading Community Architecture’s party_id for the relationship party is stored in this column.</td>
</tr>
<tr>
<td>15</td>
<td>Account External ID</td>
<td>Text</td>
<td>30</td>
<td>Entity: Party Site Attribute: party_id Note: Trading Community Architecture’s party_id for the organization is stored in this column.</td>
</tr>
</tbody>
</table>

### Contact Entity Attribute Mappings

**Table 16** lists the data mappings for contact data.

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>External Unique ID</td>
<td>Text</td>
<td>30</td>
<td>Entity: Organization Contact Attribute: relationship_id Note: Trading Community Architecture's relationship_id is stored in this column.</td>
</tr>
<tr>
<td>2</td>
<td>First Name</td>
<td>Text</td>
<td>50</td>
<td>Entity: Person Attribute: person_first_name Note: substr (50)</td>
</tr>
<tr>
<td>3</td>
<td>Last Name</td>
<td>Text</td>
<td>50</td>
<td>Entity: Person Attribute: person_last_name Note: substr (50)</td>
</tr>
<tr>
<td>4</td>
<td>Middle Name</td>
<td>Text</td>
<td>50</td>
<td>Entity: Person Attribute: person_middle_name Note: substr (50)</td>
</tr>
<tr>
<td>5</td>
<td>Mr./Mrs.</td>
<td>Picklist</td>
<td>15</td>
<td>Entity: Person Attribute: person_pre_name_adjunct</td>
</tr>
<tr>
<td>6</td>
<td>Furigana First Name</td>
<td>Text</td>
<td>50</td>
<td>Entity: Person Attribute: person_first_name_phonetic Note: substr (50)</td>
</tr>
</tbody>
</table>
Table 16. Contact Entity Attribute Mapping

<table>
<thead>
<tr>
<th>ID</th>
<th>Siebel CRM On Demand Attribute Name</th>
<th>Data Type</th>
<th>Max Length</th>
<th>Oracle E-Business Suite Attribute Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Furigana Last Name</td>
<td>Text</td>
<td>50</td>
<td>Entity: Person</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: person_last_name_phonetic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: substr (50)</td>
</tr>
<tr>
<td>9</td>
<td>Work Phone #</td>
<td>Text</td>
<td>40</td>
<td>Entity: Contact Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: raw_phone_number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: Maps to the primary (or last</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>created if no primary) contact point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>where CONTACT_POINT_TYPE='PHONE' and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PHONE_LINE_TYPE='GEN'.</td>
</tr>
<tr>
<td>10</td>
<td>Work Fax #</td>
<td>Text</td>
<td>40</td>
<td>Entity: Contact Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: raw_phone_number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: Maps to the primary (or last</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>created if no primary) contact point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>where CONTACT_POINT_TYPE='PHONE' and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PHONE_LINE_TYPE='FAX'.</td>
</tr>
<tr>
<td>11</td>
<td>Cellular Phone #</td>
<td>Text</td>
<td>40</td>
<td>Entity: Contact Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: raw_phone_number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: Maps to the primary (or last</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>created if no primary) contact point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>where CONTACT_POINT_TYPE='PHONE' and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>PHONE_LINE_TYPE='MOBILE'.</td>
</tr>
<tr>
<td>12</td>
<td>Email</td>
<td>Text</td>
<td>100</td>
<td>Entity: Contact Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Attribute: email_address</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: Primary one for contact_point_type = EMAIL</td>
</tr>
<tr>
<td>13</td>
<td>Department Name of the department of the contact</td>
<td>Text</td>
<td>75</td>
<td>Entity: Contact Attribute: department</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: See “Contact Notes” on page 84.</td>
</tr>
<tr>
<td>14</td>
<td>Job Title</td>
<td>Text</td>
<td>75</td>
<td>Entity: Contact(Attribute: job_title</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note: See “Contact Notes” on page 84.</td>
</tr>
</tbody>
</table>
Contact Notes
In Siebel CRM On Demand, organization contacts can represent multiple organizations, but these attributes are always the same for a person. However, Trading Community Architecture can maintain different attributes for each specific organization that a person is related to. Although this configuration is more flexible, the reality is that most of the time, one person represents only one organization. When Oracle E-Business Suite sends contact information to Siebel CRM On Demand, it sends only the information from the oldest organization contact record.

Product Integration
Product information is defined and maintained in Oracle E-Business Suite (in Oracle Item Master) and after the initial loading is synchronized with Siebel CRM On Demand in real time. The following topics cover product integration:

- Product Integration Notes on page 84
- User Procedures on page 85
- Product Mappings on page 85

Product Integration Notes
The following rules describe the limits and abilities of this integration:

- Only simple products (flat structure, nonhierarchal product structures) are synchronized.
- There is no synchronization of Operating Unit information, because Siebel CRM On Demand does not support it. Distinct (orderable) products, regardless of Operating Unit are synchronized.
- Catalog categories and category assignments are not synchronized.
- Only products eligible for the sales representative to quote are transferred to the Oracle E-Business Suite quote upon opportunity-to-quote conversion.
- The flags, customer ordered and customer orders enabled, must be controlled at the Master Organization level and not at the Organization level. Only items flagged as follows, customer ordered and customer orders enabled, are included as part of the initial load process into Siebel CRM On Demand.
- In the incremental load even if the flag, customer orders enabled, is not checked then the items still synchronize with Siebel CRM On Demand.
- Products in the Siebel CRM On Demand opportunity must exist on the Oracle E-Business Suite default price list during quote creation to be included in a quote. If one of the opportunity product lines does not exist in the default price list, it is not included in the quote.
- Products on the Siebel CRM On Demand opportunity must be associated with the logged-in user's item validation organization or operating unit (Org_ID) to be included in the quote during conversion. Items that do not belong to the user's associated Item Validation Org are not added to the quote.
The quantity associated with the Product Line on an Siebel CRM On Demand opportunity is passed to the corresponding line on the Oracle E-Business Suite quote upon conversion. The Unit of Measure (UOM) for the product line is derived from the item’s Primary UOM on the Oracle E-Business Suite product master.

If a product is obsolete, indicate this information in Oracle E-Business Suite by setting the Customer Ordered Enabled flag to No. Do not set the Customer Order flag to No.

**User Procedures**

The following procedures are for end users.

**TIP:** The Item Description field in Oracle E-Business Suite equates to Product Name in Siebel CRM On Demand and Long Description in Oracle E-Business Suite equates to Description in Siebel CRM On Demand. You might want to clean up the Oracle item descriptions and long descriptions before synchronizing.

*To create items or products to be synchronized*

1. In Oracle Item Master, create a new item.
2. Populate the attributes for the item.
3. Update the item status to Orderable.
   
   The item status change updates the 'Customers Ordered' and 'Customer Orders Enabled' flags and Oracle Item Master synchronizes the item with Siebel CRM On Demand Product Master.

*To modify items or products*

1. Query for the item or product in Oracle Item Master.
2. Update the item attributes.
3. Save the changes to the item.
   
   Oracle Item Master synchronizes the item with Siebel CRM On Demand Product Master.

**Product Mappings**

Table 17 lists the mappings for products.

<table>
<thead>
<tr>
<th>Attribute Names in Siebel CRM On Demand</th>
<th>Attribute Names in Oracle E-Business Suite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>ITEM_LONG_DESCRIPTION</td>
</tr>
<tr>
<td>ExternalSystemId</td>
<td>INVENTORY_ITEM_ID</td>
</tr>
</tbody>
</table>
About Integrating Customer Data, Products, and Quotes

Quote Integration

The following topics cover the details of the quote integration:

- Integration Features on page 86
- Integration Overview on page 87

Integration Features

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite provides the following features:

- Creating an Oracle E-Business Suite Quote from a Siebel CRM On Demand Opportunity on page 86
- Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Opportunity on page 87
- Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Customer Account on page 87

Creating an Oracle E-Business Suite Quote from a Siebel CRM On Demand Opportunity

From within the Siebel CRM On Demand Opportunity Detail page, you can initiate the Create Quote process by clicking a custom Web link, which creates an Oracle E-Business Suite quote as a background process. The newly created quote takes the Siebel CRM On Demand opportunity context (account - organization id, opportunity name, and so on), including the opportunity product lines during quote creation. Siebel CRM On Demand displays a summary page, listing the quotes associated with the opportunity. You can drill down on an individual quote, which launches a separate browser session in which you can update the Oracle E-Business Suite quote.

<table>
<thead>
<tr>
<th>Attribute Names in Siebel CRM On Demand</th>
<th>Attribute Names in Oracle E-Business Suite</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrderableFlag</td>
<td>CUSTOMER_ORDER_ENABLED_FLAG</td>
</tr>
<tr>
<td>PartNumber</td>
<td>CONCATENATED_SEGMENTS</td>
</tr>
<tr>
<td>ProductName</td>
<td>ITEM_SHORT_DESCRIPTION(CONCATENATED_SEGMENTS</td>
</tr>
</tbody>
</table>
Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Opportunity

From within the Siebel CRM On Demand Opportunity Detail page, you can review a listing of quotes associated with the opportunity by clicking a custom Web link. This opens an Oracle E-Business Suite page containing a summary table of quotes associated with the opportunity. You can drill down on an individual quote, which launches a separate browser session in which you can update the Oracle E-Business Suite quote.

Displaying Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Customer Account

From within the Siebel CRM On Demand Account Detail page, you can review a listing of quotes associated with the customer account by clicking a custom Web link, which opens an Oracle E-Business Suite page containing a summary table of quotes associated with the Siebel CRM On Demand customer account within an Siebel CRM On Demand custom Web tab. You can drill down on an individual quote, which launches a separate browser session in which you can update the Oracle E-Business Suite quote.

Integration Overview

The Siebel CRM On Demand Integration Pack for Oracle E-Business Suite is enabled using Siebel CRM On Demand Custom Web Tabs, Custom Web Links, and Web Services infrastructure with the Oracle E-Business Suite BPEL Process Manager. The resulting integration functionality enables the following:

- Ability to create an Oracle E-Business Suite quote from an Siebel CRM On Demand opportunity
- Ability to display Oracle E-Business Suite quotes associated with an Siebel CRM On Demand opportunity
- Ability to display all Oracle E-Business Suite quotes associated with an Siebel CRM On Demand Customer account
- Ability to display all quotes on which the user is the Primary Sales Rep
Figure 14 illustrates this functionality.

**Creating Oracle E-Business Suite Quotes from Siebel CRM On Demand Opportunities**

From within the Siebel CRM On Demand Opportunity Detail page, a user can initiate the creation of a quote by clicking a custom Web link, which creates an Oracle E-Business Suite quote as a background process. Users are directed to a summary page, listing the quotes associated with the opportunity within an Siebel CRM On Demand custom Web tab. Users are able to drill down on an individual quote, which launches a separate browser session in which the user can update the Oracle E-Business Suite quote.

Basic information from the opportunity (customer account, customer contact, product information) is carried forward to the newly created quote. Information such as sales credit, sales-team integration, and so on are not synchronized.
**About Siebel CRM On Demand Opportunity Context to Be Carried Forward to Oracle E-Business Suite Quote**

The following Siebel CRM On Demand opportunity contexts are passed to the Oracle E-Business Suite quote header to ensure the quote is created appropriately:

- Siebel CRM On Demand account > Oracle E-Business Suite Customer Name
- Siebel CRM On Demand Primary Opportunity Contact > Oracle E-Business Suite Contact Name
- Siebel CRM On Demand Opportunity Name > Oracle E-Business Suite Quote Name
- Siebel CRM On Demand Product Lines > Oracle E-Business Suite Quote Lines

When creating or updating the opportunity, if these contexts do not exist in the Siebel CRM On Demand opportunity and the create quote process is initiated, then no context is passed to Oracle E-Business Suite Quoting, and the quote creation process continues uninterrupted.

**Siebel CRM On Demand Opportunity Product Lines Must Exist on the Quoting Price List**

All products on the Siebel CRM On Demand opportunity must exist on the Oracle E-Business Suite default price list during quote creation to be included in the quote. If one of the opportunity product lines does not exist on the default price list, the quote is not created and a pricing (QP) error is thrown to the end user.

**Siebel CRM On Demand Opportunity Product Lines Must Belong to Valid Operating Unit**

All products on the Siebel CRM On Demand opportunity must be associated with the logged-in user's item validation organization operating unit (Org_ID) to be included in the quote during conversion. Items that do not belong to the user's associated Item Validation Org are not added to the quote, and no warning or error messages are displayed.

**Product Quantity and Product Unit of Measure**

The quantity associated with the product line on the Siebel CRM On Demand opportunity is passed to the corresponding line on the Oracle E-Business Suite quote upon conversion. The Unit of Measure (UOM) for the product line is derived from the item's Primary UOM on the Oracle E-Business Suite product master.

**Account Defaulting on Opportunity-to-Quote Conversion**

Upon converting the Siebel CRM On Demand opportunity to an Oracle E-Business Suite quote, the associated customer account (Account Number field on the Oracle E-Business Suite Quoting General/Overview page) is displayed by default only if one account number exists for the customer. If multiple accounts exist for the customer, no account is displayed by default. The user can then go to the Quote General page and select the valid account for the customer quote.
Quote Name Derived from the Opportunity Name
During the quote creation process, the newly created quote name is derived from the Siebel CRM On Demand opportunity name. The Siebel CRM On Demand opportunity name is not displayed on the Opportunity Name field within the Oracle E-Business Suite quote.

Display Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Opportunity
From within the Siebel CRM On Demand Opportunity Detail page, a user can review a listing of all quotes associated with the opportunity by clicking a custom Web link. This link opens an Oracle E-Business Suite page containing a summary table of all quotes associated with the opportunity within an Siebel CRM On Demand custom Web tab. The quote summary table consists of the following fixed columns:
- Quote Name (Hyperlink)
- Quote Number
- Primary Sales Person
- Status
- Creation Date
- Expiration Date
- Amount
The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate browser session in which the user can update the Oracle E-Business Suite quote.

Display Oracle E-Business Suite Quotes Associated with a Siebel CRM On Demand Customer Account
From within the Siebel CRM On Demand Account Detail page, a user can review a listing of all quotes associated with the customer account by clicking a custom Web link. This link opens an Oracle E-Business Suite page containing a summary table of quotes associated with the Siebel CRM On Demand customer account within a Siebel CRM On Demand custom Web tab.

The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate browser session in which the user can update the Oracle E-Business Suite quote.

Ability to Distinguish Between Quotes Created from Siebel CRM On Demand and Oracle E-Business Suite
Quotes generated from a Siebel CRM On Demand opportunity can be identified by displaying the Quote Overview page and checking the Opportunity Source field for the value Siebel CRM On Demand. The Opportunity Source field replaces the Opportunity Name field on both the Quote Overview page and the Quote General pages.
Quotes created from an Siebel CRM On Demand opportunity cannot be associated with an Oracle E-Business Suite opportunity, because the Opportunity Name field and LOV are replaced by the Opportunity Source field. Quotes created directly from Oracle E-Business Suite (either standalone or as part of the Oracle E-Business Suite Opportunity-to-Quote flow) have the Opportunity Name field and LOV.

**Ability to Distinguish Orders Originating from a Siebel CRM On Demand Opportunity**

Orders originating from an Siebel CRM On Demand opportunity are marked as such. Open the Sales Order form within Order Management and check the Order Source Reference field. Orders originating from Siebel CRM On Demand have a value of SEBL_<<Siebel Opportunity ID>> in that field.

**Quote Listing within the Siebel CRM On Demand Custom Web Tab**

You can review all quotes for which they are specified as the Primary Sales Rep, by clicking a custom Web tab, which directs them to a quote listing page. This same custom tab displays the quotes associated with the opportunities and accounts, based on the page (Account or Opportunity Detail page) from which you were directed.

The quotes listed are bound by a time parameter (number of days) within the invoking URL that dictates the number of quotes returned. For example, a time parameter set to 120 days returns quotes created within the last 120 days. If no time parameter is specified, the default is 30 days.

The Quote summary table consists of the following fixed columns:

- Quote Name (Hyperlink)
- Quote Number
- Customer Name
- Contact Name
- Account Number
- Expiration Date
- Status
- Amount

The table is sorted by the last-update date for the quotes. The quote listing page has the Siebel CRM On Demand look-and-feel. Users can drill down on an individual quote, which launches a separate browser session in which a user can update the Oracle E-Business Suite quote.

**Error Handling During Quote Conversion**

If an error occurs during the Siebel CRM On Demand opportunity to Oracle E-Business Suite quote conversion process, the errors are logged in the middle-tier, and the following message is displayed to the end-user:

"Quote conversion failed. Please contact your system administrator."
The message displays within the Siebel CRM On Demand custom Web tab on an Oracle E-Business Suite page.
This chapter describes troubleshooting and error message information for the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite. It contains the following sections:

- Error Messages on page 93
- Error Logging Database on page 93
- Resolving Errors on page 94
- NoClassDefFound Error on BPEL Process Auto-Deployment on page 96
- Siebel CRM On Demand to Oracle E-Business Suite Address Synchronization Failures on page 96

### Error Messages

All error messages that are displayed follow this format:

```
CRMInteg - yyy- xxxx
```

where:

- `yyy` indicates the Siebel CRM On Demand Integration Pack for Oracle E-Business Suite.
- `xxxxx` indicates an error message number. Numbers between 100 and 49,999 are fatal errors.

### Error Logging Database

Siebel CRM On Demand Integration Pack for Oracle E-Business Suite stores errors in an error logging database. Error logs are stored in a database table for ease of retrieval and analysis. For more information on this database read “Configuring the Error Logging Database” on page 25. Table 18 lists the columns in the table.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Nullable</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALLINGPROCESSNAME</td>
<td>VARCHAR2(60)</td>
<td>No</td>
<td>Stores the calling process name</td>
</tr>
<tr>
<td>CALLINGPROCESSINSTANCEID</td>
<td>VARCHAR2(10)</td>
<td>No</td>
<td>Stores the calling instance name</td>
</tr>
<tr>
<td>FAULTTEXT</td>
<td>VARCHAR2(1000)</td>
<td>Yes</td>
<td>Stores the Fault Text</td>
</tr>
<tr>
<td>FAULTSTACK</td>
<td>VARCHAR2(1000)</td>
<td>Yes</td>
<td>Stores the stack Trace</td>
</tr>
</tbody>
</table>
Troubleshooting ■ Resolving Errors

Table 18. Columns in the Error Log File

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Nullable</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAULTCONTEXT</td>
<td>VARCHAR2(200)</td>
<td>Yes</td>
<td>Stores the Fault Context</td>
</tr>
<tr>
<td>PROCESSINPUTPAYLOAD</td>
<td>BLOB</td>
<td>Yes</td>
<td>Stores the Entire Fault Payload</td>
</tr>
</tbody>
</table>

Table 19 lists the error messages used in Siebel CRM On Demand Integration Pack for Oracle E-Business Suite.

Table 19. Error Messages in Siebel CRM On Demand Integration Pack for Oracle E-Business Suite

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Encountered RemoteFault at CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>2</td>
<td>Encountered UnknownFault at CRMIntegSubscribeToCreateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>3</td>
<td>Insufficient inputs to process ProductCreate event</td>
</tr>
<tr>
<td>4</td>
<td>Encountered RemoteFault at CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>5</td>
<td>Encountered unknown fault in CRMIntegSubscribeToUpdateProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>6</td>
<td>Insufficient inputs to process ProductUpdate event</td>
</tr>
<tr>
<td>7</td>
<td>Encountered RemoteFault at CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>8</td>
<td>Encountered UnknownFault at CRMIntegSubscribeToBulkloadProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>9</td>
<td>Insufficient inputs to process Product Bulkload event</td>
</tr>
<tr>
<td>10</td>
<td>Encountered RemoteFault in process CRMIntegSyncProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>11</td>
<td>Encountered unknown fault in CRMIntegSyncProductEBS11i10ToSEBL782</td>
</tr>
<tr>
<td>12</td>
<td>Error during bulk data fetch for ProductSync</td>
</tr>
<tr>
<td>13</td>
<td>Error while fetching single item data in ProductSync process</td>
</tr>
<tr>
<td>14</td>
<td>Incorrect EventName passed to Product Sync process</td>
</tr>
</tbody>
</table>

Resolving Errors

During Siebel CRM On Demand maintenance, if the Siebel CRM On Demand server is shut down, the polling process instances has be purged and restarted after the Siebel CRM On Demand server is restarted.
In the case of a polling process (CRMIIntegSEBLODPollingSchedulerAsync) failure, perform the following:

1. Purge all instances:
   a. From the Oracle SOA Suite main page click the link for BPEL Control.
   b. Log in as an administrative user.
   c. Click Instances tab.
   d. Click Purge All Instances.
   e. Click Delete All Instances.
   f. In the warning message, click Delete All Instances.
      This step stops the Siebel CRM On Demand Polling process. When purging is complete, restart the CRMIIntegSEBLODPollingSchedulerAsync process.

2. Clear the WSDL cache:
   a. Log in to BPEL control as an administrative user.
   b. Click the BPEL Processes tab.
   c. Click the Clear WSDL Cache link.

3. Clear LastPollingWindowEnd from the od_config table.
   a. Log in to the middle-tier database with the account used to create od_config table.
   b. Execute the following SQL command:
      
      ```sql
      delete from od_config 
      where Name = 'LastPollingWindowEnd';
      ```

4. Restart SOA:
   a. Log in to Application Server Control as an administrative user.
   b. Click Expand All Application Servers
   c. Check the top level check box next to the link for middle-tier host (for example: ap6002gns.ap6002gns) and where the Type = Application Server.
   d. Click Restart > Yes.

5. Restart polling:
   a. From the Oracle SOA Suite main page click the link for BPEL Control.
   b. Log in as an administrative user.
   c. Click BPEL Processes tab.
   d. Click CRMIIntegSEBLODPollingSchedulerAsync process.
   e. Click Initiate to start this process.
   f. Provide the following values to the process:
      - Unit = S (for seconds)
NoClassDefFound Error on BPEL Process Auto-Deployment

If you receive a NoClassDefFound Error upon running ANT for the auto-deployment of BPEL processes, this may be related to multiple versions of ANT installed on your SOA Server. One version is likely configured for System Wide Installation and other for the current User Login. To correct the NoClassDefFound Error, run ANT with the noconfig option:

```
$ ANT --noconfig
```

Siebel CRM On Demand to Oracle E-Business Suite Address Synchronization Failures

If you notice that updates to address details on the Account and Contact records do not propagate from Siebel CRM On Demand to the Oracle E-Business Suite this may be related to the number of countries supported in Siebel CRM On Demand, that do not exist in the Oracle E-Business Suite. If a user specifies a country that exists in Siebel CRM On Demand and does not exist in the Oracle E-Business Suite, the entire address does not synchronize. Make sure that the country lists in both applications match.
Index

Numerics
360° view
(defined) 9
user interface, integrating 77

A
about Siebel CRM On Demand Integration Pack for Oracle E-Business Suite 11
accessibility 7
account entity attribute mappings 79
accounts 14
defined 9
displaying quotes 87
master 68
address entity attribute mappings 80
Address Import Executable 65
addresses 14
Auto Account Creation profile 48

B
BES. See Business Event System (BES)
Bill of materials (BOM) defined 9
BOM. See Bill of materials (BOM)
BPEL. See Business Processes Execution Language (BPEL)
browser setup 58
bulk loading
contact data 60
customer data 60
product data 61
Business Event System (BES) defined 9
Business Processes Execution Language defined 9
processes 47
purging process instances 40
setting options 40

C
catalog category (defined) 9
category set (defined) 9
CBM (defined) 9
CDH. See Customer Data Hub (CDH)
component overview 12

configuration 17
customer data 44
Oracle Warehouse Builder 41
product data 46
quote 47
Siebel CRM On Demand 50

configuring
CRMIntegSEBLODAddressLoader.exe.config file 64
database for
CRMIntegErrorHandlerService 40
Oracle EBS environment 41
Oracle Warehouse Builder 41
Oracle Warehouse Builder for customer integration 42
contact entity attribute mappings 82
contacts 14
bulk loading 60
defined 9
master 68
stand-alone 75
converting leads 76
Create Account/Create Contact page 70
Create New Account page 70
Create New Contact page 71
Create New Customer in SOD - Detailed Synchronization Flow 73
Create New Customers in Oracle EBS - Synchronization Flow 69
Create New Customers in SOD - Synchronization Flow 72
creating
customer record 68
synchronization accounts 44
CRMIntegErrorHandlerService, configuring database for 40
CRMIntegSEBLODAddressLoader.exe.config, configuring 64
CRMIntegSEBLODPollingSchedulerAsync, starting 40

cross-references 14
CSV files
generating customer data 61
generating product data 61
importing 62

custom fields 55, 58
customer account, displaying quotes 90
customer data
bulk loading 60
configuration 44
integration 68
mappings 78
product data 68
synchronization 67
Customer Data Hub (CDH) defined 9
customers
creating record 68
defined 9
update record 74

D
data quality 14
Data Quality Management 46
Data Quality Management options 46
data synchronization profile options 45
database triggers 8
date, synchronizing 40
displaying
quotes associated with customer account 90
quotes associated with opportunities 90
distinguish between quotes 90
distinguishing orders originating from opportunities 91
DQM. See Data Quality Management (DQM)
duplicate customer records 14

E
enabling web services 56
errors
logs 93
messages 93
quote conversion 91
External ID attribute 14
external web sites 7

F
fields, custom 55, 58
FMW. See Fusion Middleware (FMW)
Fusion Middleware (FMW) defined 9

G
generating CSV files 61
glossary 9

I
Import Wizard 63, 64
importing CSV files 62
initial loading 59
install base (defined) 9
installation 17
installing Oracle E-Business Suite software 41
integrating 360° view user interface 77
integration
customer data 68
product 84
quote 86
Integration Architecture 13
integration functionality 88
Items (defined) 10

J
jtfcuss.css 48

L
language support 15
layout modifications 53
logs, error 93

M
mappings
account entity attribute 79
address entity attribute 80
contact entity attribute 82
customer data 78
product 85
merging records 56
middleware (defined) 10
modifying roles 55
multiple organizations 84

N
new customer records 68

O
On Demand Integration URL profile 48
operating units
product lines within 89
synchronizing 84
opportunities
display quotes for 90
distinguishing orders originating from 91
opportunity name and quote name 90
opportunity product lines 89
opportunity to quote 86, 88
opportunity-to-quote conversion 89
Oracle Application Server 13
Oracle Data Browser 8
Oracle Data Quality Management 14
Oracle DQM Search Service 14
Oracle EBS
configuring environment 41
defined 10
requirements 13
Oracle Warehouse Builder
configuration 41
configuring 41
configuring for customer integration 42
defined 10
order management (defined) 10
organization contacts 14
organizations
defined 10
in cross-references 14
multiple 84
OS (defined) 10
overview, components of integration 12
OWB. See Oracle Warehouse Builder (OWB)

P
parties (defined) 10
party site 14
patches 19
persons parties 74
pick list modifications 57
PIM synchronization 57
populating XREF_DATA table 40
product data
bulk loading 61
configuration 46
synchronization 68
product integration 84
product mappings 85
product unit of measure 89
purging process instances on Business Processes Execution Language console 40

Q
quote listing within custom web tab 91
quote name derived from opportunity name 90
quotes
configuration 47
conversion errors 91
distinguishing between 90
from opportunity 86, 88
integration 86
quotes and accounts 87

R
records
duplicate 14
modifying 56
requirements
Oracle EBS 13
software 13
responsibilities 44
roles, modifying 55

S
SCOD. See Siebel CRM On Demand (SCOD)
Service Oriented Architecture Suite
defined 10
setting
Business Processes Execution Language options 40
Service Oriented Architecture Suite proxy server properties 39
Siebel CRM On Demand
configuration 50
Look-and-Feel 47
Siebel CRM On Demand (SCOD) defined 10
Siebel CRM On Demand Integration Pack for Oracle E-Business Suite, about 11
SOA. See Service Oriented Architecture (SOA)
software requirements 13
SQL*Plus 8
stand-alone contacts 75
starting
CRMIntegSEBLODPollingSchedulerAsynch process 40
style classes 48
synchronization
customer data 14, 67
date and time 40
flows 68
PIM 57
synchronization accounts, creating 44
synchronizing
operating units 84

T
TCA. See Trading Community Architecture (TCA)
Text Telephone access 7
time, synchronizing 40
Trading Community Architecture (TCA) defined 10
troubleshooting 93
TTY Access 7
### Index

<table>
<thead>
<tr>
<th>U</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit of Measure</strong> 85, 89</td>
<td><strong>web link</strong></td>
</tr>
<tr>
<td><strong>update customer record</strong> 74</td>
<td>creation 51</td>
</tr>
<tr>
<td><strong>update existing customer in Oracle EBS - synchronization flow</strong> 74</td>
<td>options 52</td>
</tr>
<tr>
<td><strong>update existing customer in SOD - synchronization flow</strong> 75</td>
<td><strong>web services, enabling</strong> 56</td>
</tr>
<tr>
<td><strong>user management</strong> 67</td>
<td><strong>web tabs</strong> 50</td>
</tr>
<tr>
<td><strong>users</strong> 44</td>
<td><strong>X</strong></td>
</tr>
<tr>
<td><strong>XREF_DATA, creating</strong> 40</td>
<td></td>
</tr>
</tbody>
</table>